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How to use this Competency Based Learning Material (CBLM) 
  

The module, contains training materials and activities for you to complete. These activities may 

be completed as part of structured classroom activities or you may be required you to work at 

your own pace. These activities will ask you to complete associated learning and practice 

activities in order to gain knowledge and skills you need to achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or tasks 

you are going to learn how to do. Once you have finished reading the Information 

Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to help 

you know how you are progressing.  If you are unable to answer the questions in the 

Self-Check you will need to re-read the relevant Information Sheet. Once you have 

completed all the questions check your answers by reading the relevant Answer Keys 

found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step by 

step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practise the job. You may need to 

practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be provided 

where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of others in 

the training room. Should you require assistance or clarification please consult your trainer or 

facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved competency 

in the specified learning outcomes. You will then be ready to move onto the next Unit of 

Competency or Module  



 

vi 
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Module Content 

 

Unit of Competency Use Spreadsheets 

Unit Code OU-AF-002-L4-V1 

Module Title Use Spreadsheets 

Module Descriptor 

This Module covers the knowledge, skills and atlitude required to use 

Spreadsheet (MS Excel and Google Sheet) applications.  

It specifically includes formatting and layout sheet, using formula and 

functions, creating chart, table and pivot, using tools and developing 

real life projects 

Nominal Hours 50 Hours 

Lerning Outcome 

After completing the practice of the module, the trainees will be able 

to perform the following jobs:  

 

1. Create Sheet formats and layouts . 

2. Use Formulas and functions. 

3. Create Charts. 

4. Create Tables and pivots. 

5. Utilize Tools. 

6. Develop Real-life projects. 

 

Assessment Criteria 

1. Sheet is prepared 

2. Sheet is formatted as per requirement 

3. Layout is made as required 

4. Functions are used as per requirements 

5. Functions are selected as required 

6. Data is accessed as per client's requirements 

7. Chart type is selected as per client's requirements 

8. Chart is created as required 

9. Chart is formatted as required 

10. Chart is presented as required 

11. Data is accessed as per client's requirements 

12. Data is formatted as Table 

13. Report is designed in Pivot as requirement 

14. Report is submitted to client 

15. Tools are selected 

16. Tools are learned 

17. Project type is determined 

18. Structure of project is designed 

19. Project is developed as per design 
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Learning Outcome 1: Sheet formats and layouts can be created. 

Assessment Criteria 

 

1. Sheets can be prepared.  

2. Sheet formats can be edited as needed.  

3. Layouts can be created as needed.  

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

Contents 

1 Prepare Sheet  

2 Format Sheet as per requirement 

3 Make Layout as required 

Activities/job/Task 
1  Create a Sample Spreadsheet Demonstrating Formatting 

Tools 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

Assessment methods may include but not limited to 

1. Written Test 

2. Demonstration 

3. Oral Questioning 

4. Portfolio   
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Learning Experience 1: Creating Sheet formats and layouts  

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

1. Trainee will ask the instructor about 

about the learning materials 

1. Instructor will provide the learning materials 

‘Create Sheet formats and layouts’ 

2. Read the Information sheet 

and complete the Self Checks 

& Check answer sheets on 

“Create Sheet formats and 

layouts” 

2. Read Information sheet 1: Create Sheet 

formats and layouts 

3. Answer Self-check 1: Create Sheet formats 

and layouts 

4. Check your answer with Answer key 1: 

Create Sheet formats and layouts 

3. Read the Job/Task Sheet and 

Specification Sheet and 

perform job/Task 

5. Job/Task Sheet and Specification Sheet  

Job Sheet 1.1: Create a Sample Spreadsheet 

Demonstrating Formatting Tools 
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Information Sheet 1: Create Sheet formats and layouts 

 
 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 

 

1.1. Prepare Sheet  

1.2. Format Sheet  

1.3. Make Layout  

 

 

1.1. Prepare Sheet 

 

This section covers the basic steps involved in creating a new spreadsheet in both 

Google Sheets and Microsoft Excel. 

 

A. Google Sheets 

 

Creating a new spreadsheet 

 

Here's a detailed guide with pictures on how to create a new spreadsheet in Google 

Sheets: 

1. Access Google Sheets 

• Open your web browser and go 

to https://docs.google.com/spreadsheets/create. 

 

2. Create a New Spreadsheet 

• You'll see a new blank spreadsheet automatically created and titled "Untitled 

Spreadsheet." 

 

https://docs.google.com/spreadsheets/create
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New blank spreadsheet in Google Sheets 

 

3. Rename the Spreadsheet: 

• Click on the title bar "Untitled Spreadsheet" to rename it. 

 

 

 

Clicking on the title bar in Google Sheets 

 

• Enter your desired name for the spreadsheet and press Enter. 

 

Opening an existing spreadsheet 

 

Here's a detailed guide with pictures on how to open an existing spreadsheet in 

Google Sheets: 

1. Access Google Drive: Open your web browser and go 

to https://www.google.com/drive/. 

 

2. Locate Your Spreadsheet: In your Google Drive, browse through your files and 

folders to find the existing spreadsheet you want to open. 

https://www.google.com/drive/


 

6 
 

 

3. Open the Spreadsheet: There are two ways to open the spreadsheet 

• Double-click: Simply double-click on the spreadsheet file to open it directly 

in Google Sheets. 

 

 

 

Doubleclicking on a spreadsheet file in Google Drive 

 

* **Right-click and choose "Open":** Right-click on the spreadsheet file and select 

"Open" from the context menu. 

 

Rightclicking on a spreadsheet file and selecting Open in Google Drive 
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B. Microsoft Excel 

 

Creating a new workbook (spreadsheet) 

 

Open Microsoft Excel: 

Locate the Microsoft Excel icon on your computer. It's typically found in the Start 

menu or on your desktop. Double-click the icon to launch the program. 

 

New Blank Workbook Creation: 

 

Once Excel opens, you'll see a new blank workbook automatically created and 

displayed. 

This workbook contains a single worksheet by default, named "Sheet1." 

 

 

 

New blank workbook in Microsoft Excel 

 

You've successfully created a new workbook in Microsoft Excel. Now you can start 

entering data, formatting it, and building your spreadsheet for various purposes. 

 

 

Opening an existing workbook 

 

You can locate a workbook on your computer and simply double-click it to open it, but you can also open a 

workbook from within the Excel program. 

1. Click the File tab. 
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2. Click Open. 

Press Ctrl + O to quickly display the Open tab of the Backstage view. 

3. Select the location where the file is saved. 

You can choose from: 

• Recent: Recent files you've worked on. 

• Shared with Me: Files others have shared with you on OneDrive or SharePoint Online. 

• OneDrive: Microsoft's cloud-based storage. 

• This PC: Browse files on your local computer. 

• Browse: Opens a dialog box where you can browse through your computer's folders, drives, 

and network shares. 

 

4. Select the file you want to open. 

5. Click Open. 
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1.2. Format Sheet 

 

A. Font 

 

Formatting text or numbers can make them appear more visible especially when you 

have a large worksheet. Changing default formats includes things like changing the font 

color, style, size, text alignment in a cell, or apply formatting effects. This article shows 

you how you can apply different formats and also undo them. 
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If you want text or numbers in a cell to appear bold, italic, or have a single or double 

underline, select the cell and on the Home tab, pick the format you want 

 

 
 

Change font style, size, color, or apply effects 

 

Click Home and 

▪ For a different font style, click the arrow next to the default font Calibri and pick 

the style you want. 

▪ To increase or decrease the font size, click the arrow next to the default size 11 

and pick another text size. 
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▪ To change the font color, click Font Color and pick a color. 

▪ To add a background color, click Fill Color next to Font Color. 

 

 
 

To apply strikethrough, superscript, or subscript formatting, click the Dialog Box 

Launcher, and select an option under Effects. 
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B. Alignment 

 

You can position the text within a cell so that it is centered, aligned left or right. If it’s a 

long line of text, you can apply Wrap Text so that all the text is visible. 

Select the text that you want to align, and on the Home tab, pick the alignment option 

you want. 

 

 

 

C. Advanced formatting 

i. Available number formats in Excel 

In Excel, you can format numbers in cells for things like currency, percentages, 

decimals, dates, phone numbers, or social security numbers. 

1. Select a cell or a cell range. 

2. On the Home tab, select Number from the drop-down. 
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Or, you can choose one of these options: 

▪ Press CTRL + 1 and select Number. 

▪ Right-click the cell or cell range, select Format Cells… , and 

select Number. 

▪ Select the small arrow, dialog box launcher, and then select Number. 

3. Select the format you want. 

ii. Number formats 

To see all available number formats, select the Dialog Box Launcher next 

to Number on the Home tab in the Number group. 

 

 

Format Description 

General The default number format that Excel applies when you type a 

number. For the most part, numbers that are formatted with 

the General format are displayed just the way you type them. 

However, if the cell is not wide enough to show the entire 

number, the General format rounds the numbers with decimals. 

The General number format also uses scientific (exponential) 

notation for large numbers (12 or more digits). 

Number Used for the general display of numbers. You can specify the 

number of decimal places that you want to use, whether you want 

to use a thousands separator, and how you want to display 

negative numbers. 

Currency Used for general monetary values and displays the default 

currency symbol with numbers. You can specify the number of 

decimal places that you want to use, whether you want to use a 

thousands separator, and how you want to display negative 

numbers. 
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Format Description 

Accounting Also used for monetary values, but it aligns the currency symbols 

and decimal points of numbers in a column. 

Date Displays date and time serial numbers as date values, according 

to the type and locale (location) that you specify. Date formats 

that begin with an asterisk (*) respond to changes in regional date 

and time settings that are specified in Control Panel. Formats 

without an asterisk are not affected by Control Panel settings. 

Time Displays date and time serial numbers as time values, according 

to the type and locale (location) that you specify. Time formats 

that begin with an asterisk (*) respond to changes in regional date 

and time settings that are specified in Control Panel. Formats 

without an asterisk are not affected by Control Panel settings. 

Percentage Multiplies the cell value by 100 and displays the result with a 

percent (%) symbol. You can specify the number of decimal 

places that you want to use. 

Fraction Displays a number as a fraction, according to the type of fraction 

that you specify. 

Scientific Displays a number in exponential notation, replacing part of the 

number with E+n, where E (which stands for Exponent) 

multiplies the preceding number by 10 to the nth power. For 

example, a 2-decimal Scientific format displays 12345678901 as 

1.23E+10, which is 1.23 times 10 to the 10th power. You can 

specify the number of decimal places that you want to use. 

Text Treats the content of a cell as text and displays the content 

exactly as you type it, even when you type numbers. 

Special Displays a number as a postal code (ZIP Code), phone number, 

or Social Security number. 

Custom Allows you to modify a copy of an existing number format code. 

Use this format to create a custom number format that is added to 

the list of number format codes. You can add between 200 and 

250 custom number formats, depending on the language version 

of Excel that is installed on your computer. For more information 

about custom formats,  

 

D. Format numbers 

Apply number formats such as dates, currency, or fractions to cells in a worksheet. For 

example, if you’re working on your quarterly budget, you can use the Currency number 

format so your numbers represent money. Or, if you have a column of dates, you can 

specify that you want the dates to appear as March 14, 2012, 14-Mar-12, or 3/14. 
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Follow these steps to format numbers: 

1. Select the cells containing the numbers you need to format. 

2. Select CTRL+1. 

3. In the window that displays, select the Number tab (skip this step if you're using 

Microsoft 365 for the web). 

4. Select a Category option, and then select specific formatting changes on the 

right. 

 

i. Display numbers as percentages 

To quickly apply percentage formatting to selected cells, click Percent Style  in 

the Number group on the Home tab, or press Ctrl+Shift+%. If you want more 

control over the format, or you want to change other aspects of formatting for your 

selection, you can follow these steps. 

1. On the Home tab, in the Number group, select the icon next to Number to 

display the Format Cells dialog box. 
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2. In the Format Cells dialog box, in the Category list, select Percentage. 

 

3. In the Decimal places box, enter the number of decimal places that you 

want to display. For example, if you want to see 10% instead of 10.00%, 

enter 0 in the Decimal places box. 

 

ii. Format numbers as currency 

You can display a number with the default currency symbol by selecting the cell or 

range of cells, and then clicking Accounting Number Format  in 

the Number group on the Home tab. (If you want to apply the Currency format 

instead, select the cells, and press Ctrl+Shift+$.) 

If you want more control over either format, or you want to change other aspects of 

formatting for your selection, you can follow these steps. 

Select the cells you want to format 

On the Home tab, click the Dialog Box Launcher next to Number. 
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Tip: You can also press Ctrl+1 to open the Format Cells dialog box. 

In the Format Cells dialog box, in the Category list, 

click Currency or Accounting. 

 

In the Symbol box, click the currency symbol that you want. 

Note: If you want to display a monetary value without a currency symbol, you can 

click None. 

In the Decimal places box, enter the number of decimal places that you want for the 

number. For example, to display $138,691 instead of $138,690.63 in the cell, 

enter 0 in the Decimal places box. 

As you make changes, watch the number in the Sample box. It shows you how 

changing the decimal places will affect the display of a number. 

In the Negative numbers box, select the display style you want to use for negative 

numbers. If you don't want the existing options for displaying negative numbers, 

you can create your own number format.  

To close the Format Cells dialog box, click OK. 

iii. Conditional formatting 

Conditional formatting can help make patterns and trends in your data more 

apparent. To use it, you create rules that determine the format of cells based on their 
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values, such as the following monthly temperature data with cell colors tied to cell 

values.  

 

You can apply conditional formatting to a range of cells (either a selection or a 

named range), an Excel table, and in Excel for Windows, even a PivotTable report. 

Conditional formatting makes it easy to highlight certain values or make particular 

cells easy to identify. This changes the appearance of a cell range based on a 

condition (or criteria). You can use conditional formatting to highlight cells that 

contain values which meet a certain condition. Or you can format a whole cell range 

and vary the exact format as the value of each cell varies. 

Temperature information with conditional formatting applied that shows top 10% 

and bottom 10% values 

 

Temperature information with 3-color scale conditional formatting applied 

 

Apply conditional formatting 

1. Select the range of cells, the table, or the whole sheet that you want to apply 

conditional formatting to. 

2. On the Home tab, click Conditional Formatting. 

 

3. Do one of the following: 
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To highlight Do this 

Values in specific cells. Examples are dates after this 

week, or numbers between 50 and 100, or the bottom 

10% of scores. 

Point to Highlight 

Cells 

Rules or Top/Bottom 

Rules, and then click 

the appropriate 

option. 

The relationship of values in a cell range. Extends a 

band of color across the cell. Examples are 

comparisons of prices or populations in the largest 

cities. 

Point to Data Bars, 

and then click the fill 

that you want. 

The relationship of values in a cell range. Applies a 

color scale where the intensity of the cell's color 

reflects the value's placement toward the top or bottom 

of the range. An example is sales distributions across 

regions. 

Point to Color 

Scales, and then click 

the scale that you 

want. 

A cell range that contains three to five groups of 

values, where each group has its own threshold. For 

example, you might assign a set of three icons to 

highlight cells that reflect sales below $80,000, below 

$60,000, and below $40,000. Or you might assign a 5-

point rating system for automobiles and apply a set of 

five icons. 

Point to Icon Sets, 

and then click a set. 

 

E. Styles 

To apply several formats in one step, and to make sure that cells have consistent 

formatting, you can use a cell style. A cell style is a defined set of formatting 

characteristics, such as fonts and font sizes, number formats, cell borders, and cell 

shading. To prevent anyone from making changes to specific cells, you can also use a 

cell style that locks cells. 
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Microsoft Office Excel has several built-in cell styles that you can apply or modify. You 

can also modify or duplicate a cell style to create your own, custom cell style. 

i. Apply a cell style 

1. Select the cells that you want to format.  

2. On the Home tab, in the Styles group, click the More dropdown arrow in the 

style gallery, and select the cell style that you want to apply. 
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F. Border 

The fastest way to make a border in Excel is to apply one of the inbuilt options 

directly from the ribbon. Here's how: 

1. Select a cell or a range of cells to which you want to add borders. 

2. On the Home tab, in the Font group, click the down arrow next to 

the Borders button, and you will see a list of the most popular border types. 

3. Click the border you want to apply, and it will be immediately added to the 

selected cells. 

For example, this is how you can apply an outside border around cells in Excel 

 

 

How to insert border in Excel with Format Cells dialog 

The Format Cells dialog is the most effective method of adding borders in Excel. It 

gives you easy access to all the settings including the line color and thickness as 

well as a nice diagram preview. 

To insert a border via the Format Cells dialog, this is what you need to do 

1. Select one or more cells to which you'd like to add borders. 

2. Open the Format Cells dialog box by doing one of the following: 

o Click the down arrow next to the Borders button, and then 

click More Borders at the bottom of the drop-down list. 

o Right click the selected cells and choose Format Cells… from the 

context menu. 
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o Press Ctrl+1 shortcut. 

 

3. In the Format Cells dialog box, switch to the Border tab and choose the 

line style and color first. And then, either use Presets to add the outside or 

inside borders or construct the desired border by selecting individual 

elements such as border top, bottom, right or left. The preview diagram will 

reflect the changes immediately. 

4. When done, click OK. 
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G. Header and footer 

i. How to add header in Excel 

Inserting a header in an Excel worksheet is quite easy. Here's what you do: 

1. Go to the Insert tab > Text group and click the Header & Footer button. 

This will switch the worksheet to Page Layout view. 

 

2. Now, you can type text, insert a picture, add a preset header or specific 

elements in any of the three Header boxes at the top of the page. By 

default, the central box is selected 
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If you wish the header to appear in the top left or top right corner of the page, click 

the left or right box and enter some information there. 

3. When finished, click anywhere in the worksheet to leave the header area. 

To exit the header box without keeping the changes, press Esc. 

When you print out your worksheet, the header will be repeated on each page. 

 

ii. How to insert footer in Excel 

Like an Excel header, a footer can also be inserted in a few easy steps 

1. On the Insert tab, in the Text group and click the Header & Footer button. 

2. On the Design tab, click Go to Footer or scroll down to the footer boxes at 

the bottom of the page. 

 

3. Depending on the desired location, click the left, center, or right footer box, 

and type some text or insert the element you want.  

4. When done, click anywhere in the worksheet to exit the footer area. 

For example, to insert page numbers at the bottom of the worksheet, select one of 

the footer boxes and click Page Number on the Design tab, in the Header & 

Footer group. 
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H. Page Setup/Margin 

In Excel, if you want to print a paper report, you have the option to change the page 

margins according to your need. By default, the margins that you have are 1.78 cm for 

the left and right, and 1.91 for the bottom and top. 

 

You can change these margins as per your requirement. In this tutorial, we will look at 

all the different options and methods that you have in Excel to change the page margins. 
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i. Change Page Margin in Excel 

1. First, go to the Page Layout Tab. 

2. After that, go to the page setup option group. 

3. Next, click on the “Page Layout” drop-down. 

4. In the end, select the page margin setting that you want to use. 

 

There are three major pre-defined settings you can use: Normal (Default), Wide, and 

Narrow. 
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In the dialog box, you can change the page margin values and set a new one. 

 

ii. Format painter in Excel 

When it comes to copying formatting in Excel, Format Painter is one of the most 

helpful and underused features. It works by copying the formatting of one cell and 

applying it to other cells. 

With just a couple of clicks, it can help you reproduce most, if not all of the 

formatting settings, including: 

• Number format (General, Percentage, Currency, etc.) 

• Font face, size, and color 

• Font characteristics such as bold, italic, and underline 

• Fill color (cell background color) 

• Text alignment, direction and orientation 

• Cell borders 

In all Excel versions, the Format Painter button is located on the Home tab, in 

the Clipboard group, right next to the Paste button 



 

28 
 

 

 

 

iii. How to use Format Painter in Excel 

To copy cell formatting with the Excel Format Painter, just do the following: 

1. Select the cell with the formatting you want to copy. 

2. On the Home tab, in the Clipboard group, click the Format Painter button. 

The pointer will change to a paint brush. 

3. Move to the cell where you want to apply the formatting and click on it. 

Done! The new formatting is copied to your target cell. 

 

I. Cut Copy Paste 

Cut, Copy, and Paste are useful operations in Excel XP. You can quickly copy and/or 

cut information in cells and paste them into other cells. These operations save you from 

having to type and retype the same information. 

The Cut, Copy, and Paste buttons are located on the Standard toolbar. 
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The Cut, Copy, and Paste operations also appear as choices in the Edit menu. 

 

The Cut, Copy, and Paste operations can also be performed using shortcut keys. 

Cut Ctrl+X 

Copy Ctrl+C 

Paste Ctrl+V 

i. Copying and pasting cell contents 

The Copy feature allows you to copy selected information from the spreadsheet 

and temporarily place it on the Clipboard, which is a temporary storage file in your 

computer's memory. The Paste feature allows you to select any of the collected 

items on the Clipboard and paste it in a cell of the same or different spreadsheet. 

To copy and paste: 

• Select a cell or cells to be duplicated. 

• Click the Copy button on the Standard toolbar. 

• The border of the copied cell(s) takes on the appearance of marching ants. 
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• Click the cell where you want to place the duplicated information. The cell 

will be highlighted. If you are copying contents into more than one cell, 

click the first cell where you want to place the duplicated information. 

 

• Press the Enter key. Your information is copied to the new location. 

ii. Cutting and pasting cell contents 

The Cut feature allows you to remove information from cells in the spreadsheet. 

Information that is cut can be pasted in another cell, as long as the pasting occurs 

before you perform another operation. If you don't paste the cut information 

immediately, it is removed from the Office clipboard. 

To cut and paste: 

• Select a cell or cells to be cut. 

• Click the Cut button on the Standard toolbar. 

• The information in the cell is deleted. 

• The border of the cut cell(s) take on the appearance of marching ants. 
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• Click the cell where you want to place the duplicated information. The cell 

will be highlighted. If you are copying contents into more than one cell, 

click the first cell where you want to place the duplicated information. 

 

• Press the Enter key. Your information is pasted to the new location. 

iii. Moving information using the drag-and-drop method 

Another way to move information from one cell to another is to use the drag-and-

drop method. You use the cursor to point to the information to be moved and then 

drag the cell to its new location. 

To use drag and drop: 

• Highlight and select the cell(s) you want to move to a new location. 

• Position the mouse pointer near one of the outside edges of the selected 

cell(s). The mouse pointer changes from a large white cross into a slender 

black cross with arrows at all ends. 

 

• Keep the mouse pointer on the outer edge of the selected cell, click and 

hold the left mouse button, and drag the cell(s) to a new location. 
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• Release the mouse button to move the information to its new location. 

 

1.3. Make Layouts  

 

i. Page Layout view 

 

Before you start modifying a workbook's page layout, you may want to view the 

workbook in Page Layout view, which can help you visualize your changes. 

• To access Page Layout view, locate and select the Page Layout view command 

in the bottom-right corner of your workbook. 

 

 

ii. Page orientation 

 

Excel offers two page orientation options: landscape and portrait. Landscape orients 

the page horizontally, while portrait orients the page vertically. Portrait is especially 

helpful for worksheets with a lot of rows, while landscape is best for worksheets with 

a lot of columns. In the example below, portrait orientation works best because the 

worksheet includes more rows than columns. 

 

 
 

 



 

33 
 

iii. To change page orientation 

1. Click the Page Layout tab on the Ribbon. 

2. Select the Orientation command, then choose either Portrait or Landscape from 

the drop-down menu. 

 

 

3. The page orientation of the workbook will be changed. 

 

iv. To format page margins 

 

A margin is the space between your content and the edge of the page. By default, 

every workbook's margins are set to Normal, which is a one-inch space between the 

content and each edge of the page. Sometimes you may need to adjust the margins to 

make your data fit more comfortably on the page. Excel includes a variety 

of predefined margin sizes. 

1. Click the Page Layout tab on the Ribbon, then select the Margins command. 

2. Select the desired margin size from the drop-down menu. In our example, we'll 

select Narrow to fit more of our content on the page. 
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3. The margins will be changed to the selected size. 

 

v. To include Print Titles: 

 

If your worksheet uses title headings, it's important to include these headings on each 

page of your printed worksheet. It would be difficult to read a printed workbook if the 

title headings appeared only on the first page. The Print Titles command allows you 

to select specific rows and columns to appear on each page. 

1. Click the Page Layout tab on the Ribbon, then select the Print 

Titles command. 

 

2. The Page Setup dialog box will appear. From here, you can 

choose rows or columns to repeat on each page. In our example, we'll repeat a 

row. 

3. Click the Collapse Dialog button next to the Rows to repeat at top: field. 
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4. The cursor will become a small selection arrow and the Page Setup dialog box 

will be collapsed. Select the row(s) you want to repeat at the top of each printed 

page. In our example, we'll select row 1. 

 

5. Row 1 will be added to the Rows to repeat at top: field. Click the Collapse 

Dialog button again. 

 

6. The Page Setup dialog box will expand. Click OK. Row 1 will be printed at the 

top of every page. 
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vi. To insert a page break 

 

If you need to print different parts of your workbook across separate pages, you can 

insert a page break. There are two types of page breaks: vertical and horizontal. 

Vertical page breaks separate columns, while horizontal page breaks separate rows. In 

our example, we'll insert a horizontal page break. 

1. Locate and select the Page Break view command. The worksheet will appear in 

Page Break view. 

 

2. Select the row below where you want the page break to appear. For example, if 

you want to insert a page break between rows 28 and 29, select row 29. 
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3. Click the Page Layout tab on the Ribbon, select the Breaks command, then 

click Insert Page Break. 

 

4. The page break will be inserted, represented by a dark blue line. 
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When viewing your workbook in Normal view, inserted page breaks are represented 

by a solid gray line, while automatic page breaks are represented by a dashed line. 
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Self-Check Sheet - 1: Create Sheet formats and layouts 

1. Which of the following is NOT a way to format text in a cell of Microsoft Excel? 

A. Change the font style (bold, italic, underline)  

B. Increase the font size  

C. Change the text color  

D. Add a background image  

2. What does wrapping text in Excel do? 

A. Bolds the text  

B. Makes the text all uppercase   

C. Allows long text to display completely within a cell   

D. Underlines the text  

3. In Excel, what format would you use to display a number as a percentage? 

A. Currency   

B. Number   

C. Percentage   

D. Date  

4. What is the purpose of conditional formatting in Excel? 

A. To create a border around a cell   

B. To highlight data based on specific rules or conditions   

C. To merge cells together   

D. To change the font style of all text in a worksheet  

5. What does the Format Painter tool in Excel do? 

A. Copies formatting from one cell and applies it to other cells   

B. Inserts a page break   

C. Changes the orientation of the page   

D. Adds a header or footer  

6. In Excel, what is the difference between portrait and landscape page orientation? 

A. There is no difference.   

B. Portrait displays the page vertically, while landscape displays it horizontally.   

C. Portrait displays more rows, while landscape displays more columns.   

D. Portrait is used for text-heavy documents, while landscape is used for images.  
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7. What does the "Margin" setting in Excel control? 

A. The space between text and the edge of the cell   

B. The font size of the text   

C. The space between the content of your worksheet and the edge of the page   

D. The color of the cell borders  
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Answer Key - 1: Create Sheet formats and layouts 

1. Which of the following is NOT a way to format text in a cell of Microsoft Excel? 

E. Change the font style (bold, italic, underline)  

F. Increase the font size  

G. Change the text color  

H. Add a background image  

Answer: D  

2. What does wrapping text in Excel do? 

E. Bolds the text  

F. Makes the text all uppercase   

G. Allows long text to display completely within a cell   

H. Underlines the text  

Answer: C  

3. In Excel, what format would you use to display a number as a percentage? 

E. Currency   

F. Number   

G. Percentage   

H. Date  

Answer: C  

4. What is the purpose of conditional formatting in Excel? 

E. To create a border around a cell   

F. To highlight data based on specific rules or conditions   

G. To merge cells together   

H. To change the font style of all text in a worksheet  

Answer: B  

5. What does the Format Painter tool in Excel do? 

E. Copies formatting from one cell and applies it to other cells   

F. Inserts a page break   

G. Changes the orientation of the page   

H. Adds a header or footer  

Answer: A  
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6. In Excel, what is the difference between portrait and landscape page orientation? 

E. There is no difference.   

F. Portrait displays the page vertically, while landscape displays it horizontally.   

G. Portrait displays more rows, while landscape displays more columns.   

H. Portrait is used for text-heavy documents, while landscape is used for images.  

Answer: B 

7. What does the "Margin" setting in Excel control? 

E. The space between text and the edge of the cell   

F. The font size of the text   

G. The space between the content of your worksheet and the edge of the page   

H. The color of the cell borders  

Answer: C  
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Job Sheet-1.1: Create a Sample Spreadsheet Demonstrating 

Formatting Tools 

 

Steps to Follow 

1. Create a New Spreadsheet: Open your preferred spreadsheet software and start a 

new document. 

2. Sample Data: Enter some sample data into the spreadsheet. This could be a list of 

products, expenses, or any data that allows you to showcase formatting options. 

3. Formatting Tools: Dedicate a section of your spreadsheet for each of the following 

formatting tools and demonstrate its functionality:  

o Font: Change the font style, size, and color of text in a designated area. 

o Alignment: Align text in cells to the left, right, center, or justify within a 

specific section. 

o Advanced Formatting: Apply strikethrough, underline, or 

subscript/superscript to text in a designated area. 

4. Conditional Formatting: Create a rule that changes the cell color based on a specific 

condition (e.g., highlight cells with values greater than 10). 

5. Styles: Create a custom cell style that includes specific font, alignment, and border 

settings. Apply this style to a designated section of your data. 

6. Border: Apply different border styles to cells or groups of cells to visually separate 

sections. 

7. Header and Footer: Add a header with your name and a footer with the page number 

to your spreadsheet. 

8. Page Setup/Margin: Adjust the margins of your spreadsheet and potentially change 

the page orientation (portrait/landscape) to demonstrate these settings. 

9. Format Painter: Choose a formatted cell or group of cells, then use the format 

painter tool to copy the formatting and apply it to another section. 

10. Cut, Copy, Paste: Demonstrate cutting, copying, and pasting content within the 

spreadsheet. 

11. Sorting and Filtering: Sort a column of your data alphabetically (ascending or 

descending). Additionally, apply a filter to show only specific data sets within your 

sample data. 

Deliverable: 

• A completed spreadsheet showcasing the use of each formatting tool listed above. 

• Each section of the spreadsheet should be clearly labeled to indicate the specific 

formatting tool being demonstrated. 
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Specification Sheet-1.1: Create a Sample Spreadsheet Demonstrating 

Formatting Tools 
 

 

Necessary Tools  
 

Sl. No Name of Tools Specification Unit Quantity 

1      

 

Necessary Equipment 
 

Sl. No Name of Equipment Specification Unit Quantity 

1.  Computer  As Need No. 01 

2.  Spreadsheet Software  As Need No. 01 
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Learning Outcome 2: Formulas and functions can be used. 

 

Assessment Criteria 

 

1. functions are identified  

2. Functions are used 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

Contents 

1. Functions 

a. Logical Functions are learned 

b. Text Functions are learned 

c. Financial Functions are learned 

d. Math Functions are learned 

e. Information Function for error checking 

f. Lookup Functions 

g. Date and Time Functions 

2. Use of functions 

Activities/job/Task 
1. Demonstrate communication with customers. 

2. Demonstrate rapport building techniques 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

Assessment methods may include but not limited to 

1. Written Test 

2. Demonstration 

3. Oral Questioning 

4. Portfolio   
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Learning Experience 2: Use Formulas and functions  

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

a. Trainee will ask the instructor about 

about the learning materials 

1. Instructor will provide the learning materials 

‘Use Formulas and functions’  

b. Read the Information sheet 

and complete the Self Checks 

& Check answer sheets on 

“Use Formulas and functions” 

2. Read Information sheet 1: Use Formulas and 

functions 

3. Answer Self-check 1: Use Formulas and 

functions 

4. Check your answer with Answer key 1: Use 

Formulas and functions 

c. Read the Job/Task Sheet and 

Specification Sheet and 

perform job/Task 

5. Job/Task Sheet and Specification Sheet  

Job Sheet-2: Create a worksheet using 

Logical, Text and Financial Function 
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Information Sheet 2: Use Formulas and functions 

 
 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 

 

2.1. Functions  

2.2. Use of Functions  

 

2.1. And 2.2 Identify and use Functions  

 

Excel functions are pre-written formulas that help you perform calculations, 

manipulate data, and analyze information in your spreadsheets. They offer a powerful 

way to automate tasks and save you time. 

 

Here's a breakdown of key points about Excel functions: 

 

• Variety of Functions: Excel boasts a vast library of functions categorized by 

their purpose. Common categories include: 

o Basic: SUM, AVERAGE, COUNT, MAX, MIN (for performing 

calculations) 

o Statistical: Functions to analyze data distribution (e.g., STDEV for 

standard deviation) 

o Logical: Functions to make comparisons and test conditions 

(e.g., IF, AND, OR) 

o Text: Functions to manipulate text data (e.g., CONCATENATE to 

combine text) 

o Date & Time: Functions to work with dates and times 

(e.g., TODAY, DATEDIF) 

o Many more! 

• Using Functions: All functions begin with an equal sign (=) followed by the 

function name and then parentheses containing arguments. Arguments are the 

values or cell references the function uses for calculations. 

• Benefits of Functions: 

o Automation: Functions automate repetitive tasks, saving you time and 

effort. 
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o Accuracy: They minimize errors compared to manual calculations. 

o Flexibility: Functions can handle complex calculations and data 

manipulation. 

o Consistency: Ensure consistent formulas across your spreadsheet. 

 

 

i. Logical Functions  

 

Microsoft Excel provides 4 logical functions to work with the logical values. The 

functions are AND, OR, XOR and NOT. You use these functions when you want 

to carry out more than one comparison in your formula or test multiple conditions 

instead of just one. As well as logical operators, Excel logical functions return 

either TRUE or FALSE when their arguments are evaluated. 

 

The following table provides a short summary of what each logical function does 

to help you choose the right formula for a specific task. 

 

Function Description 
Formula 

Example 

Formula 

Description 

AND 

Returns TRUE if 

all of the 

arguments 

evaluate to 

TRUE. 

=AND(A2>=10, 

B2<5) 

The formula returns 

TRUE if a value in 

cell A2 is greater 

than or equal to 10, 

and a value in B2 is 

less than 5, FALSE 

otherwise. 

OR 

Returns TRUE if 

any argument 

evaluates to 

TRUE. 

=OR(A2>=10, 

B2<5) 

The formula returns 

TRUE if A2 is 

greater than or equal 

to 10 or B2 is less 

than 5, or both 

conditions are met. If 

neither of the 

conditions it met, the 

formula returns 

FALSE. 
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Function Description 
Formula 

Example 

Formula 

Description 

XOR 

Returns a logical 

Exclusive Or of 

all arguments. 

=XOR(A2>=10, 

B2<5) 

The formula returns 

TRUE if either A2 is 

greater than or equal 

to 10 or B2 is less 

than 5. If neither of 

the conditions is met 

or both conditions 

are met, the formula 

returns FALSE. 

NOT 

Returns the 

reversed logical 

value of its 

argument. I.e. If 

the argument is 

FALSE, then 

TRUE is returned 

and vice versa. 

=NOT(A2>=10) 

The formula returns 

FALSE if a value in 

cell A1 is greater 

than or equal to 10; 

TRUE otherwise. 

 

In additions to the four logical functions outlined above, Microsoft Excel provides 

3 "conditional" functions - IF, IFERROR and IFNA. 

 

Excel logical functions - facts and figures 

1. In arguments of the logical functions, you can use cell references, numeric 

and text values, Boolean values, comparison operators, and other Excel 

functions. However, all arguments must evaluate to the Boolean values of 

TRUE or FALSE, or references or arrays containing logical values. 

2. If an argument of a logical function contains any empty cells, such values 

are ignored. If all of the arguments are empty cells, the formula returns 

#VALUE! error. 

3. If an argument of a logical function contains numbers, then zero evaluates 

to FALSE, and all other numbers including negative numbers evaluate to 

TRUE. For example, if cells A1:A5 contain numbers, the formula 

=AND(A1:A5) will return TRUE if none of the cells contains 0, FALSE 

otherwise. 
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4. A logical function returns the #VALUE! error if none of the arguments 

evaluate to logical values. 

5. A logical function returns the #NAME? error if you've misspell the 

function's name or attempted to use the function in an earlier Excel version 

that does not support it. For example, the XOR function can be used in Excel 

2016 and 2013 only. 

6. In Excel 2007 and higher, you can include up to 255 arguments in a logical 

function, provided that the total length of the formula does not exceed 8,192 

characters. In Excel 2003 and lower, you can supply up to 30 arguments and 

the total length of your formula shall not exceed 1,024 characters. 

 

A. Using the AND function in Excel 

 

The AND function is the most popular member of the logic functions family. 

It comes in handy when you have to test several conditions and make sure that 

all of them are met. Technically, the AND function tests the conditions you 

specify and returns TRUE if all of the conditions evaluate to TRUE, FALSE 

otherwise. 

The syntax for the Excel AND function is as follows 

AND(logical1, [logical2], …) 

 

Where logical is the condition you want to test that can evaluate to either 

TRUE or FALSE. The first condition (logical1) is required, subsequent 

conditions are optional. 

 

And now, let's look at some formula examples that demonstrate how to use the 

AND functions in Excel formulas. 

 

Formula Description 

=AND(A2="Bananas", 

B2>C2) 

Returns TRUE if A2 contains "Bananas" and 

B2 is greater than C2, FALSE otherwise. 

=AND(B2>20, 

B2=C2) 

Returns TRUE if B2 is greater than 20 and 

B2 is equal to C2, FALSE otherwise. 

=AND(A2="Bananas", 

B2>=30, B2>C2) 

Returns TRUE if A2 contains "Bananas", B2 

is greater than or equal to 30 and B2 is greater 

than C2, FALSE otherwise. 
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B. Excel AND function – common uses 

 

By itself, the Excel AND function is not very exciting and has narrow 

usefulness. But in combination with other Excel functions AND can 

significantly extend the capabilities of your worksheets. 

 

One of the most common uses of the Excel AND function is found in the 

logical_test argument of the IF function to test several conditions instead of 

just one. For example, you can nest any of the AND functions above inside the 

IF function and get a result similar to this: 

=IF(AND(A2="Bananas", B2>C2), "Good", "Bad") 

 
 

 

An Excel formula for the BETWEEN condition 

 

If you need to create a between formula in Excel that picks all values between 

the given two values, a common approach is to use the IF function with AND 

in the logical test. 

For example, you have 3 values in columns A, B and C and you want to know 

if a value in column A falls between B and C values. To make such a formula, 

all it takes is the IF function with nested AND and a couple of comparison 

operators: 
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Formula to check if X is between Y and Z, inclusive 

 

=IF(AND(A2>=B2,A2<=C2),"Yes", "No") 

 

Formula to check if X is between Y and Z, not inclusive 

 

=IF(AND(A2>B2, A2<C2),"Yes", "No") 

 

 
 

As demonstrated in the screenshot above, the formula works perfectly for all 

data types - numbers, dates and text values. When comparing text values, the 

formula checks them character-by-character in the alphabetic order. For 

example, it states that Apples in not between Apricot and Bananas because the 

second "p" in Apples comes before "r" in Apricot.  

 

As you see, the IF /AND formula is simple, fast and almost universal. I say 

"almost" because it does not cover one scenario. The above formula implies 

that a value in column B is smaller than in column C, i.e. column B always 

contains the lower bound value and C - the upper bound value. This is the 

reason why the formula returns "No" for row 6, where A6 has 12, B6 - 15 and 

C6 - 3 as well as for row 8 where A8 is 24-Nov, B8 is 26-Dec and C8 is 21-

Oct. 
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But what if you want your between formula to work correctly regardless of 

where the lower-bound and upper-bound values reside? In this case, use the 

Excel MEDIAN function that returns the median of the given numbers (i.e. the 

number in the middle of a set of numbers). 

So, if you replace AND in the logical test of the IF function with MEDIAN, 

the formula will go like: 

 

=IF(A2=MEDIAN(A2:C2),"Yes","No") 

 

And you will get the following results 

 
As you see, the MEDIAN function works perfectly for numbers and dates, but 

returns the #NUM! error for text values.  

 

If you want a perfect Between formula that works for text values as well as for 

numbers and dates, then you will have to construct a more complex logical 

text using the AND / OR functions, like this 

 

 

=IF(OR(AND(A2>B2, A2<C2), AND(A2<B2, A2>C2)), "Yes", "No") 
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C. Using the OR function in Excel 

 

As well as AND, the Excel OR function is a basic logical function that is used 

to compare two values or statements. The difference is that the OR function 

returns TRUE if at least one if the arguments evaluates to TRUE, and returns 

FALSE if all arguments are FALSE. The OR function is available in all 

versions of Excel 2016 - 2000. 

 

The syntax of the Excel OR function is very similar to AND 

OR(logical1, [logical2], …) 

Where logical is something you want to test that can be either TRUE or 

FALSE. The first logical is required, additional conditions (up to 255 in 

modern Excel versions) are optional. 

 

And now, let's write down a few formulas for you to get a feel how the OR 

function in Excel works. 

 

Formula Description 

=OR(A2="Bananas", 

A2="Oranges") 

Returns TRUE if A2 contains "Bananas" or 

"Oranges", FALSE otherwise. 

=OR(B2>=40, 

C2>=20) 

Returns TRUE if B2 is greater than or equal to 

40 or C2 is greater than or equal to 20, FALSE 

otherwise. 

=OR(B2=" ", C2="") 
Returns TRUE if either B2 or C2 is blank or 

both, FALSE otherwise. 
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As well as Excel AND function, OR is widely used to expand the usefulness 

of other Excel functions that perform logical tests, e.g. the IF function. Here 

are just a couple of examples: 

 

IF function with nested OR 

=IF(OR(B2>30, C2>20), "Good", "Bad") 

 

The formula returns "Good" if a number in cell B3 is greater than 30 or the 

number in C2 is greater than 20, "Bad" otherwise. 

 

Excel AND / OR functions in one formula 

 

Naturally, nothing prevents you from using both functions, AND & OR, in a 

single formula if your business logic requires this. There can be infinite 

variations of such formulas that boil down to the following basic patterns: 

 

=AND(OR(Cond1, Cond2), Cond3) 

=AND(OR(Cond1, Cond2), OR(Cond3, Cond4) 

=OR(AND(Cond1, Cond2), Cond3) 

=OR(AND(Cond1,Cond2), AND(Cond3,Cond4)) 

For example, if you wanted to know what consignments of bananas and 

oranges are sold out, i.e. "In stock" number (column B) is equal to the "Sold" 

number (column C), the following OR/AND formula could quickly show this 

to you: 

 

=OR(AND(A2="bananas", B2=C2), AND(A2="oranges", B2=C2)) 
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D. OR function in Excel conditional formatting 

 

=OR($B2="", $C2="") 

The rule with the above OR formula highlights rows that contain an empty cell 

either in column B or C, or in both. 

 

 
 

E. Using the XOR function in Excel 

 

In Excel 2013, Microsoft introduced the XOR function, which is a 

logical Exclusive OR function. This term is definitely familiar to those of you 

who have some knowledge of any programming language or computer science 

in general. For those who don't, the concept of 'Exclusive Or' may be a bit 

difficult to grasp at first, but hopefully the below explanation illustrated with 

formula examples will help. 

 

The syntax of the XOR function is identical to OR's  

XOR(logical1, [logical2],…) 

 

The first logical statement (Logical 1) is required, additional logical values are 

optional. You can test up to 254 conditions in one formula, and these can be 

logical values, arrays, or references that evaluate to either TRUE or FALSE. 

 

In the simplest version, an XOR formula contains just 2 logical statements and 

returns 
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• TRUE if either argument evaluates to TRUE. 

• FALSE if both arguments are TRUE or neither is TRUE. 

 

This might be easier to understand from the formula examples 

 

Formula Result Description 

=XOR(1>0, 

2<1) 
TRUE 

Returns TRUE because the 1st argument is 

TRUE and the 2nd argument is FALSE. 

=XOR(1<0, 

2<1) 
FALSE 

Returns FALSE because both arguments are 

FALSE. 

=XOR(1>0, 

2>1) 
FALSE 

Returns FALSE because both arguments are 

TRUE. 

 

When more logical statements are added, the XOR function in Excel results in 

 

• TRUE if an odd number of the arguments evaluate to TRUE; 

• FALSE if is the total number of TRUE statements is even, or if all 

statements are FALSE. 

The screenshot below illustrates the point 

 

 
 

If you are not sure how the Excel XOR function can be applied to a real-life 

scenario, consider the following example. Suppose you have a table of 

contestants and their results for the first 2 games. You want to know which of 

the payers shall play the 3rd game based on the following conditions 
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• Contestants who won Game 1 and Game 2 advance to the next round 

automatically and don't have to play Game 3. 

• Contestants who lost both first games are knocked out and don't play 

Game 3 either. 

• Contestants who won either Game 1 or Game 2 shall play Game 3 to 

determine who goes into the next round and who doesn't. 

 

A simple XOR formula works exactly as we want 

 

=XOR(B2="Won", C2="Won") 

 
 

And if you nest this XOR function into the logical test of the IF formula, you 

will get even more sensible results 

 

=IF(XOR(B2="Won", C2="Won"), "Yes", "No") 

 

 
 

 

F. Using the NOT function in Excel 

 

The NOT function is one of the simplest Excel functions in terms of syntax 

NOT(logical) 
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You use the NOT function in Excel to reverse a value of its argument. In other 

words, if logical evaluates to FALSE, the NOT function returns TRUE and 

vice versa. For example, both of the below formulas return FALSE 

 

=NOT(TRUE) 

=NOT(2*2=4) 

 

Why would one want to get such ridiculous results? In some cases, you might 

be more interested to know when a certain condition isn't met than when it is. 

For example, when reviewing a list of attire, you may want to exclude some 

color that does not suit you. I'm not particularly fond of black, so I go ahead 

with this formula 

 

=NOT(C2="black") 

 
 

As usual, in Microsoft Excel there is more than one way to do something, and 

you can achieve the same result by using the Not equal to operator: 

=C2<>"black". 

If you want to test several conditions in a single formula, you can use NOT in 

conjunctions with the AND or OR function. For example, if you wanted to 

exclude black and white colors, the formula would go like 

 

=NOT(OR(C2="black", C2="white")) 

 

And if you'd rather not have a black coat, while a black jacket or a back fur 

coat may be considered, you should use NOT in combination with the Excel 

AND function: 

 

=NOT(AND(C2="black", B2="coat")) 
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Another common use of the NOT function in Excel is to reverse the behavior 

of some other function. For instance, you can combine NOT and ISBLANK 

functions to create the ISNOTBLANK formula that Microsoft Excel lacks. 

 

As you know, the formula =ISBLANK(A2) returns TRUE of if the cell A2 is 

blank. The NOT function can reverse this result to FALSE: 

=NOT(ISBLANK(A2)) 

And then, you can take a step further and create a nested IF statement with the 

NOT / ISBLANK functions for a real-life task 

 

=IF(NOT(ISBLANK(C2)), C2*0.15, "No bonus :(") 

 

 
 

Translated into plain English, the formula tells Excel to do the following. If 

the cell C2 is not empty, multiply the number in C2 by 0.15, which gives the 

15% bonus to each salesman who has made any extra sales. If C2 is blank, the 

text "No bonus :(" appears. 

 

In essence, this is how you use the logical functions in Excel. Of course, these 

examples have only scratched the surface of AND, OR, XOR and NOT 

capabilities. Knowing the basics, you can now extend your knowledge by 

tackling your real tasks and writing smart elaborate formulas for your 

worksheets. 

 

ii. Text Functions  

 

A. Excel TEXT function - syntax and basic uses 

 

In its pure essence, TEXT in Excel is used to convert a numeric value to a text 

string in a specific format. 
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The syntax for the Excel TEXT function is as follows 

TEXT(value, format_text) 

 

Where 

 

• Value - the numeric value to be converted to text. It can be a number, 

date, reference to a cell containing a numeric value or another function 

that returns a number or date. 

• Format_text - the format that you want to apply. It is supplied in the 

form of a format code enclosed in the quotation marks, e.g. "mm/dd/yy". 

 

The TEXT function is available in all versions of Excel 365, Excel 2021, Excel 

2019, Excel 2016, Excel 2013, Excel 2010, Excel 2007, and lower. 

 

Generally, an Excel TEXT formula is used in the following situations: 

• To display numbers in a more readable way or in a format that makes 

more sense for your users. 

• To display dates in a specific format. 

• To combine numbers or dates with certain text or characters. 

 

For example, if you want to pull the date from cell A2 and show it in another 

cell in the traditional date format like "January 1, 2016", you use the following 

Excel TEXT formula: 

 

=TEXT(A2, "mmmm d, yyyy") 

 

 
 

 

The result will look similar to this 

 

Important note! The TEXT function in Excel converts a numeric value to a 

text strings. Consequently, you won't be able to use the result of your Text 

formula in other calculations. If there's such a need, you can keep the original 

values (hidden or kept out of sight), and use them in other formulas. 
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B. Excel TEXT function format codes 

 

As you have just seen, the syntax of the Excel TEXT function is very 

straightforward, a tricky part is supplying a proper format code that will output 

your number the way you want. Essentially, the TEXT function accepts most 

of the format codes used in Excel number formats. The table below lists the 

most common and frequently used ones. 

 

Code Description Format code example 

0 

Digit 

placeholder 

that displays 

insignificant 

zeros. 

#.00 - always displays 2 decimal places. 

If you type 2.5 in the referenced cell, it will 

display as 2.50. 

# 

Digit 

placeholder 

that does not 

display 

extra zeros. 

#.## - displays up to 2 decimal places. 

If you type 2.5, it will display as 2.5. 

If you type 2.555, it will display as 2.56. 

? 

Digit 

placeholder 

that leaves a 

space for 

insignificant 

zeros but 

doesn't 

display 

them. It is 

generally 

used to align 

numbers in 

a column at 

a decimal 

point. 

#.?? - displays a maximum of 2 decimal 

places and aligns the decimal points in a 

column. 
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Code Description Format code example 

. 

(period) 

Decimal 

point 
  

, 

(comma) 

Thousands 

separator. 

###,###.## - displays a thousands 

separator and 2 decimal places. 

If you type 250000, it will display as 

250,000.00 

 

Additionally, you can include any of the following characters in the format 

code, and they will be displayed exactly as entered. 

 

Symbol Description 

+ and - Plus and minus signs 

( ) Left and right parenthesis 

: Colon 

^ Caret 

' Apostrophe 

{ } Curly brackets 

< > Less-than and greater than signs 

= Equal sign 

/ Forward slash 

! Exclamation point 

& Ampersand 

~ Tilde 

 Space character 
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The following spreadsheet shows how you can use a Text formula in Excel to 

apply different formatting types to the same value. 

 

  A B C 

1 
Original 

Value 

Formatted 

Value 
Formula 

2 5.5 5.50 =TEXT(A2, "0.00") 

3   550% =TEXT(A2,"#%") 

4   $5.50 =TEXT(A2, "$#,##0.00") 

5   + $5.50 
=TEXT(A2, "+ $#,##0.00;- 

$#,##0.00;$0.00") 

6   - $5.50 
=TEXT(A2, "- $#,##0.00;- 

$#,##0.00;$0.00") 

7   5 1/2 =TEXT(A2,"# ?/?") 

8   5.50E+00 =TEXT(A2,"0.00E+00") 

9   ~6 ! =TEXT(A2,"~# !") 

 

When using the Excel TEXT function with dates and times, you can use any 

of the following format codes. 

 

Format 

code 
Description Examples 

d 

Day of 

month, or 

day of week 

d - one or two-digit number without a 

leading zero (1 to 31) 

dd - two-digit number with a leading zero 

(01 to 31) 

ddd - three-letter abbreviation (Mon to 

Sun) 

dddd - full name of day of week (Monday 

to Sunday) 

m 

Month 

(when used 

as part of a 

date) 

m - one or two-digit number without a 

leading zero (1 to 12) 

mm - two-digit number with a leading zero 

(01 to 12) 

mmm - abbreviated month (Jan to Dec) 
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Format 

code 
Description Examples 

mmmm - full name of month (January to 

December) 

y Year 

yy - two-digit number (e.g. 06 meaning 

2006 or 16 meaning 2016) 

yyyy - four digit number (e.g. 2006, 2016) 

h Hour 

h - one or two-digit number without a 

leading zero (1 to 24) 

hh - two-digit number with a leading zero 

(01 to 24) 

m 

Minute 

(when used 

as part of 

time) 

m - one or two-digit number without a 

leading zero (1 to 60) 

mm - two-digit number with a leading zero 

(01 to 60) 

s Second 

s - one or two-digit number without a 

leading zero (1 to 60) 

ss - two-digit number with a leading zero 

(01 to 60) 

AM/PM 
Time represented as a 12-hour clock, followed by "AM" or 

"PM" 

 

The following spreadsheet shows a few Excel Text formulas for dates 

 

  A B C 

1 
Original 

Date 

Formatted 

Date 
Formula 

2 12/09/2016 Dec 09 2016 =TEXT(A2, "mmm dd yyyy") 

3   

Friday 09 

December, 

2016 

=TEXT(A2, "dddd dd mmmm, 

yyyy") 

4   9-Dec-16 =TEXT(A2, "d-mmm-yy") 

5   Friday =TEXT(A2,"dddd") 
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C. How to use TEXT function in Excel - formula examples 

 

So far, you might have an impression that the use of the Excel TEXT function 

is quite limited (because a value's display can easily be changed using 

the Format Cells dialog available via a cell's context menu or Ctrl+1 shortcut). 

The situation changes as soon as you start using TEXT in combination with 

other Excel functions. The below examples will give you a few inspirational 

ideas. 

 

Concatenate text and number (or date) in a custom format 

 

When creating summary sheets or reports, you may often want not only 

calculate totals, percentages and the like, but also explain to your users what 

this or that number means. To do this, use the CONCATENATE function to 

join text and numbers, and the TEXT function to display the number (or date) 

like you want it. 

 

Example 1. Format numbers inside a text string 

 

Supposing you calculate the total amount based on the unit price in cell A2, 

quantity in B2, and discount percentage in C2 using this 

calculation: =A2*B2*(1-C2). For your users to know exactly what the output 

number means, you wish to display it together with some explanatory text like 

"Your price is". Additionally, you want to show the currency symbol, 

thousands separator and two decimal places. 

To have it done, supply the above calculation in the 1st argument of the TEXT 

function, include the corresponding format code in the 2nd argument, and 

concatenate the Text formula with a string using either the ampersand operator 

or CONCATENATE function: 

="Your price is "&TEXT(A2*B2*(1-C2), "$###,###.00") 

or 

= CONCATENATE("Your price is ",TEXT(A2*B2*(1-C2), 

"$###,###.00")) 
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The following screenshot demonstrates the result 

 

 
 

 

 

 

Example 2. Combine text and date in the desired format 

 

When you return the current date using TODAY() or NOW() function, you 

may also want to display it in combination with some text so that no one has 

any doubt what day this date refers to. 

 

However, if you try to concatenate a text and date in the usual way 

 

=CONCATENATE("Today is ", TODAY()) 

 

Excel will return a very odd result, something like "Today is 42198". 

 

The point is that in the internal Excel system, dates are stored as numbers, and 

that number appears in a concatenated text string. To fix this, use the TEXT 

function to display the date the way you want. 

 

For example, embedding the TODAY function in the Text formula with the 

format code "dddd d mmm, yyyy" will return a string similar to this: "Today 

is Monday 12 Dec, 2016". 
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The complete formula goes as follows 

 

=CONCATENATE("Today is ", TEXT(TODAY(), "dddd d mmm, 

yyyy")) 

Or 

 
 

="Today is " & TEXT(TODAY(), "dddd d mmm, yyyy") 

 

 

D. Add leading zeros to numbers with variable lengths 

 

As you know, Microsoft Excel automatically removes leading zeros typed 

before a number in a cell, which works fine in most situations. But what if you 

want to keep the preceding zeros? 

 

The Excel TEXT function can be an easy solution to pad numbers with leading 

zeros in a column, even if the original values are not the same length. Simply 

use the format code containing only zero placeholders like "0000000", where 

the number of zeros corresponds to the number of digits you want to display. 

 

For example, to display 7-digit numbers with leading zeros, use this formula 

(where A2 is the original number) 

=TEXT(A2,"00000 00") 

 

As you can see in the screenshot below, our Excel Text formula adds as many 

leading zeros as necessary to make a 7-character long string (please remember, 

the result of the TEXT function in Excel is always a text string, even if it looks 

like a number). 
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E. Convert values to phone numbers in a specific format 

 

Turning a column of numeric values into telephone numbers may sound like a 

tricky task, but only until you remember that the Excel TEXT function allows 

using dashes and parentheses in format codes. 

So, to display a number in A2 in a traditional US local 7-digit phone format 

like 123-456, use this formula 

=TEXT(A2, "###-####") 

If some of the original values may contain a domestic prefix (i.e. there can be 

both 7-digit or 10-digit numbers), include the following conditional format 

code to display 10-digit numbers in the (123) 456-789 format 

 

=TEXT(A2,"[<=9999999]###-####;(###) ###-####") 

 

The screenshot below shows this Excel Text formula in action 

 

 
 

F. Excel TEXT function not working – reasons and solutions 

 

Compared to other Excel functions, TEXT is very simple and painless, and you 

are unlikely to have any difficulties when using it in your spreadsheets. If, 

against all expectations, a Text formula is not working for you, in most cases 

it's because of an incorrect format code input in the format_text argument. Here 

are two most typical issues 



 

70 
 

 

1. The TEXT function returns the #NAME? error if you omit the quotation 

marks around the format code. 

 

For example the formula =TEXT(A2, mm/dd/yy) is incorrect and should be 

written this way: =TEXT(A2, "mm/dd/yy") 

 

2. The TEXT function in Excel is language-specific, and requires using 

region-specific date and time format codes. 

 

For example, the formula =TEXT(A2, "mm/dd/yy") that works fine for 

English users may return the #VALUE error in other locales. In particular, in 

Germany, you'd need to use the following format codes: "t" instead of "d" and 

"j" instead of "y" because "day" in German is "tag" and year is "jahr"; 

"m"(month) is fine because in German it also begins with "m" (monat). So, in 

German Excel, the above formula will read as follows: =TEXT(A2; 

"mm/tt/jj"). In France, you'd use the "mm/jj/aa" format code because "day" is 

"jour", "month" is "mois", and "year" is "an". 

 

Also, please pay attention that in European countries, the List Separator is 

usually set to semicolon, not comma, and therefore ";" should be used to 

separate the formula's arguments. 

 

iii. Financial Functions  

 

A. Applications of Financial Functions 

 

Financial functions are used for calculating a diverse set of common key 

performance indicators in a business, or for predicting the value of money through 

time. The time value of money theory states that money loses value as time passes. 

It is a simple concept that is ingrained in every business decision because it is 

important for a business to use financial instruments and investments to increase 

the value of their savings or idle cash. One way you can see this theory in practice 

is in the steady increase in the sales prices of goods over time. 

 

B. Common Financial Functions in Practice 

 

You were introduced to the Excel function PMT in The Advantages of a Data 

Table for determining the monthly (or yearly, daily, or quarterly) payment of an 

investment or loan. There are other important variables involved in the financial 
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functions related to the time value of money theory, which can help a business 

determine profitability. This section will focus on an annual payment rather than 

a monthly payment. But keep in mind, many loans require monthly payments and 

the variables in the function will need to be adjusted accordingly. 

 

There are five main time value of money variables (PMT, RATE, NPER, PV, and 

FV) used in these calculations. Table  lists these variables and what they represent 

in Excel. To find the answer to a time value of money problem, you must have the 

values of at least three of the five variables. There is an additional variable that 

you need to consider and that is “Type.” In the functions, “Type” represents when 

payments are made. If they are made at the beginning of the term, use 1 in the 

function. If you do not enter anything, Excel will use the default of “0,” meaning 

payments are made at the end of the term. The timing of the payments impacts the 

amount of interest paid. 

 

One way to calculate any of these time value of money variables is to use a 

financial calculator, which works like a regular calculator, except that it has 

certain financial functions programmed into it. A financial calculator has a button 

associated with each of the time value of money variables. Excel also has these 

functions programmed into it. 

 

Variable Definition 

PMT 
The payment of an investment or loan per period (usually 

monthly) 

RATE The interest rate on an investment, loan, or bond yield 

NPER 
The number of periods in a calculation (usually years, 

quarters, or months) 

PV The initial investment of a business or security purchase 

FV 
The monetary value of a business or security investment at 

the end of all periods 

Type 

Whether payments are made at the beginning of the term 

or at the end of the term; the default is “0” or at the end of 

the term 

Table:  Time Value of Money Variables 
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a. PMT 

 

To calculate PMT, you need at least three of the other variables. For this 

example, assume that WorldCorp is building a new manufacturing plant, at 

a cost of $4,743,542. To finance the investment, they will borrow the money 

from a bank, rather than use their savings. The bank terms are 5.6 percent for 

a twelve-year loan. You will use these variables to find the amount 

WorldCorp will pay each year for a loan. You know the loan term (NPER, 

which is the number of periods for the loan), the interest rate (RATE), and 

the original amount of the loan (PV). You do not know the future value (FV) 

or the yearly payment installment (PMT). 

Excel performs these time value of money calculations using functions and 

the values of the known variables. First, construct a table that lists the five 

variables and the values you have. You can then use the Excel function to 

calculate PMT. Recall that this function can be found on the Formulas tab 

under Financial in the Function Library command group. You enter all of the 

values into the dialog box or in the Formula Bar using the cell references.  

 

 
 

 

Figure: If you do not know the installment, but you know the periods, the 

interest, and the principal, you can calculate the installment. Excel will use 

the default of “0” for type. You do not need to enter anything for FV.  
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Figure shows the yearly installment WorldCorp will have to pay on this loan. 

As was noted in The Advantages of a Data Table, Excel gives the PMT 

answer as a negative number by default. You can change this by putting a “-

” sign in front of the PV cell reference or after the “=” in the formula in the 

Formula Bar. 

 

 
 

Figure Notice the final answer is negative (as indicated by “()” and red font. 

(b) The “-” in front of D3 changes the installment payment to a positive 

number.  

 

b. RATE 

 

The RATE function works in the same way as the PMT function. Again, you 

can find the RATE function in the financial functions library. For this 

example, WorldCorp wants to open another manufacturing plant for making 

headphones. The cost of the site and the machinery is $3,843,974, but they 

will use a down payment of $450,000. The loan they would need then would 

be $3,393,974 (total cost − $450,000). The bank loan will be over twelve 

years, with yearly payments of $427,308.08. You need to determine the 

interest rate. Figure shows the table of variables, but this time the interest rate 

is missing. You can then use the RATE function to determine the interest 

rate. 
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Figure:You can find the interest rate if you have the loan term, the loan 

amount, and the payment. Recall that you need at least three of the 

variables and be sure to enter a “-” in front of the PMT.  

 

 

Figure: The function returns the interest rate based on the other variable 

values. 

 

NPER 

You can use the NPER function in Excel in the same way as the other time 

value of money functions to determine the amount of time required to repay 

the loan. For this example, WorldCorp has decided to change the look of their 

retail stores. They asked you, a financial analyst, to find the best bank loan 

terms—the one that costs the company the least amount in total payment. 
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The average cost of each store renovation is $64,757. Bank X offers an 

interest rate of 5.45 percent and Bank Y offers an interest rate of 6.55 percent.  

 

Bank Y is your current bank, and you have a great working relationship with 

the employees. You want to keep banking there, but want to understand the 

long-term impact of the higher interest rate for this loan. You have budgeted 

$1,500 each month toward the loan for an annual payment of $18,000 

($1,500 × 12 months). You can use those values in the NPER 

function Figure to determine the repayment time period for each loan Figure, 

which you can then use to determine the total payment of the loan. You 

would multiply the PMT by the NPER you just found. 

 

 

Figure: Bank X and Bank Y offer different interest rates. Use the NPER 

function to find the number of payment periods for Bank X.  
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Figure: Repeat the NPER function for Bank Y. 

 

The difference between the two options might not seem that significant: 4.11 

years compared with 4.24 years. However, when you take that number and 

multiply it by the yearly installment, you can see the overall difference 

between the two loans. For Bank X, you will pay a total of $74,027.02 (= 

4.11 × $1,800) and using the same process for Bank Y, the total cost is 

$76,239.91. It would save you more than $2,000 by going with Bank X. You 

will need to decide if that is enough savings to take the business away from 

your current bank. This example shows you that sometimes decisions are not 

always based on the numbers. Sometimes nonfinancial aspects must be 

considered when making decisions such as this. 
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c. PV 

 

Excel’s PV function allows you to calculate the principal of a loan. Suppose 

you are WorldCorp’s new financial analyst, and your supervisor asked you 

to track down all of the company’s outstanding bank loans and their original 

principals. The first loan you find has a monthly payment of $8,673.38, a 

period of eight years and an annual interest rate of 6.55 percent. As with other 

examples, the first step is to set up your table of information. However, the 

table you have been using has the term set up in years, but the term of this 

loan is in months. You will need to multiply 8 years by 12 months to get 

NPER, and you will need to divide your annual interest (RATE) by 12 

months to get the monthly interest. Now that you have converted all of your 

figures to months, you can use the PV function from Excel to get the original 

principal of $646,743.00. 

 

 
 

Figure: The financial functions in Excel are based on yearly information. 

The Excel function PV calculates the principal of a loan, but you need to 

convert yearly information to monthly information. 
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Figure: PV gives you the principal amount of the loan based on the interest 

rate and repayment period.  

 

LINK TO LEARNING 

 

An amortization schedule is a summary table of all the principal and interest 

payments made on a loan. This helps the borrower understand the impact of the 

interest rate and the timeline to pay back a loan such as one for a car or a home. 

Excel is a great tool for constructing such a table.  

 

d. FV 

 

The final time value of money function you will use is for the future value, 

which the previous examples have not used. For this example, you will 

analyze a stock investment. As a financial analyst at WorldCorp, you need to 

assess the value of investments in a savings account to determine whether it 

would be better for WorldCorp to use this cash for buying stock of other 

companies to get a greater return. The stocks they are considering will 

increase in market value in the future, so you will need to calculate the 

amount WorldCorp will gain when they sell it. They have $5,456,254.00 in 

their savings account now. They are considering investing that savings in 

other company stocks that increase in value on average 6.57 percent per year, 

and they would plan to hold on to the stock for nine years. You would use 

the FV function, as shown in Figure to determine this value. You can then 

compare that with what they would get if they just keep the funds in the 

savings account during that nine-year time period.  
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Figure: In this example, there is no annual payment you are making. 

Calculating the future value uses the FV function and three of the other four 

time value of money variables. Excel assumes PMT is “0” if no value is 

entered. 

 

 

 

Figure:Again, like the other functions, the result will be negative if you do 

not add the “-” before the investment amount.  
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e. Depreciation 

 

Depreciation is not one of the five variables used in time value of money 

theory, but it is an important function used in accounting. The steady 

decrease in value of an asset, such as a piece of equipment, over time is 

called depreciation. The IRS lets businesses calculate depreciation as an 

expenditure, which in turn reduces the total amount they are taxed each year. 

There are several different depreciation functions in Excel, but this section 

will focus on the DB (declining balance) function. This is one of the most 

used methods of depreciation in accounting. With this function, you are 

essentially reducing the total value of the asset over a period of time. 
 

The formula for depreciation takes into account the original price, the current 

market value of the item (or the salvage value), the years of use (or useful 

life), and the period. The years of use is the average lifespan of the machine. 

The period is the time that has passed since the purchase. The other variable 

in the function is Month. This can be used if the machine was purchased in 

the middle of the year. Excel will assume a normal twelve-month year for the 

first year if you leave this value blank. The number you enter here is the 

number of months the business owned the asset during a partial year. For this 

example, you will use the values in Figure, which shows the DB 

function. Figure shows the depreciation of the asset. As shown, during period 

2, the machine is $18,627.12 less than its original value, meaning that in year 

2 the machine is worth $61,372.88 (or $80,000 − $18,627.12). 
 

 

Figure: The salvage value is the worth of the asset if you were to sell it. 

The DB function calculates depreciation, which can reduce a company’s 

taxes.  
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Figure: The resulting value is the annual depreciation of the asset to be 

deducted as an expense.  

f. Math Functions  

 

In MS Excel, formulas are equations that perform various calculations in your 

worksheets. Though Microsoft has introduced a handful of new functions 

over the years, the concept of Excel spreadsheet formulas is the same in all 

versions of Excel 2016, Excel 2013, Excel 2010, Excel 2007 and lower. 

 

• All Excel formulas begin with an equal sign (=). 

• After the equal symbol, you enter either a calculation or function. For 

example, to add up values in cells B1 through B5, you can either 

 

o Type the entire equation: =B1+B2+B3+B4+B5 

o Use the SUM function: =SUM(B1:B5) 

 

• Press the Enter key to complete the formula. Done! 
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Elements of Microsoft Excel formulas 

 

When you make a formula in Excel, you can use different elements to supply 

the source data to the formula and indicate what operators should be 

performed on those data. Depending on the formula type that you create, it 

can include any or all of the following parts: 

• Constants - numbers or text values that you enter directly in a formula, 

like =2*3. 

• Cell references - reference to a cell containing the value you want to 

use in your Excel formula, e.g. 

=SUM(A1, A2, B5). 

To refer to data in two or more contiguous cells, use a range reference like 

A1:A5. For example, to sum values in all cell between A1 and A5, inclusive, 

use this formula 

=SUM(A1:A5). 

• Names - defined name for a cell range, constant, table, or function, for 

example =SUM(my_name). 

• Functions - predefined formulas in Excel that perform calculations 

using the values supplied in their arguments. 

• Operators - special symbols that specify the type of operation or 

calculation to be performed. 
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Operators in Excel worksheet formulas 

 

To tell Microsoft Excel what type of operation you want to perform in a 

formula, you use special symbols that are technically called operators. There 

exist 4 types of operators in Excel 

• Arithmetic - to perform basic mathematical operations. 

• Comparison (logical) - to compare values. 

• Concatenation - to join text values into a single string. 

• Reference - to make ranges and separate arguments in Excel functions. 

 

A. Using arithmetic operators in Excel formulas 

 

These operators are used to perform basic mathematical operations such 

as addition, subtraction, multiplication, and division. 

 

Operator Meaning Formula example 

+ (plus sign) Addition =A2+B2 

- (minus sign) 

Subtraction 

Negation (reversing 

the sign) 

=A2-B2 

=-A2 (changes the 

sign of the value in 

A2) 

* (asterisk) Multiplication =A2*B2 

/ (forward slash) Division =A2/B2 

% (percent sign) Percentage 

=A2*10% 

(returns 10% of the 

value in A2) 

^ (caret) 
Exponential (power 

of) 

=A2^3 

(raises the number in 

A2 to the power of 3) 

For example, if you have an item price in cell A2 and VAT in cell B2, 

you can calculate the VAT amount by using the following percentage 

formula: =A2*B2 
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B. Comparison operators in Excel formulas 

 

In Microsoft Excel formulas, comparison, or logical, operators are used 

to compare two values. The result of the comparison is always a logical 

value of TRUE or FALSE. The following logical operators are available 

in Excel 

 

Comparison operator Meaning 
Formula 

example 

= Equal to =A2=B2 

<> Not equal to =A2<>B2 

> Greater than =A2>B2 

< Less than =A2<B2 

>= Greater than or equal to =A2>=B2 

<= Less than or equal to =A2<=B2 

 

For example, formula =A1=B1 returns TRUE if cells A1 and B1 contain 

the same value (number, text or date), FALSE otherwise. 

 

C. Text concatenation operator 

 

Text concatenation operator in Excel is the ampersand symbol (&). You 

can use it to join two or more text strings in a single string. 

For example, if you have country codes in column A and telephone 

numbers in column B, you can use the following formula to get the 

telephone numbers combined with the country codes 

=A1&" "&B1 

In the above formula, we concatenate a space " " in between to make the 

numbers better readable 
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D. Reference operators in Excel formulas and functions 

 

To supply ranges to MS Excel formulas and separate arguments in Excel 

functions, the following operators are used. 

 

Colon (:) - it is a range operator that allows you to make one reference 

for multiple cells located between 2 cells that you specify. 

 

For example, range A1:A00 includes 100 cells from A1 through A100. 

To find an average of those 100 cells, you use the following formula 

 

=AVERAGE(A1:A00) 

 

You can also refer to the entire column (A:A) or the entire row (1:1). 

For example, the following formula finds the total of all numbers in 

column A: =SUM(A:A).  

 

Comma (,) - is used to separate arguments in Excel spreadsheet formulas. 

For example, the formula =IF(A1>0, "good", "bad") reads as follows: 

if A1 is greater than zero, return "good", otherwise "bad". 

 

Note. Comma is the default List Separator in North America and some 

other countries. In European countries, comma is reserved as the Decimal 

Symbol and the List Separator is usually set to semicolon (;). In this case, 

you need to separate a function's arguments with semicolons, e.g. 

=IF(A1>0; "good"; "bad") 

So, if you are trying to make a formula in your worksheet, but Excel does 

not accept it and throws up an "invalid formula" error, go to your Regional 

Settings (Control Panel > Region and Language > Additional 

Settings) and check what symbol is set as List Separator there. It is that 

symbol that you need to use to separate arguments in your Excel formulas. 

 



 

86 
 

Space - it is an intersection operator that lets you get the cell(s) common 

to the two references that you specify. For example, if you a list of items 

in column A and some related data in other columns, you can get a value 

at the 

intersection of a given column and row by using a formula like this 

 

=B3:D3 C2:C4 

 
 

 

Excel formula types 

 

Formulas that you create in your Excel spreadsheets can be simple or 

complex: 

• Simple Excel formulas perform just one mathematical operation, for 

example =10*5 or =SUM(A1:A10) 

• Complex (advanced) Excel formulas include more than one 

calculation, for example =10*5+20 or =SUM(A1:A10)/2 

 

 

How to create formulas in Excel 

 

As already mentioned, any Excel formula starts with the equal sign (=). So, 

whatever formula you are going to write, begin by typing = either in the 

destination cell or in the Excel formula bar. And now, let's have a closer look 

at how you can make different formulas in Excel. 

 

 

How to create advanced formulas in Excel 

 

When you have some experience with simple Excel formulas, you may want 

to perform several calculations within a single formula. And the following 

examples show how you can do this. 

 

Creating complex formulas with constants and mathematic operators 
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For a complex Excel formula to calculate correctly, certain operations must 

be performed before others. The default order of operations in Excel formulas 

is this 

• Mathematical operations enclosed in parenthesis 

• Power of (exponential calculations) 

• Multiplication and division, whichever comes first in a formula 

• Addition and subtraction, whichever comes first in a formula 

 

For example, you can use the following formulas to calculate the total and 

commission 

 

 
 

 

And now, let's break down these formulas to see how Microsoft Excel 

calculates them: 

Total formula: =$B2*$D2+$B2*$D2*$C2 

• 1st multiplication: $B2*$D2 (price*qty. = amount) 

• 2nd and 3rd multiplications: $B2*$D2*$C2 (price*qty.*VAT % = VAT 

amount) 

• Addition: amount + VAT amount = total 

 

Commission formula: =($B2*$D2+$B2*$D2*$C2)*10% 

 

To calculate the 10% commission, you need to multiply the total by 10%, so 

you enclose the previous calculation in brackets, and got the result you want. 

 

Of course, nothing prevents you from multiplying the total already calculated 

in column E by 10%, in this case the formula would reduce to a simple 

calculation =E2*10%. However, in large worksheets, it makes sense to write 

independently calculated formulas, so that removing a column with one 

formula wouldn't break the others. 
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Excel formulas with nested functions 

 

In Microsoft Excel formulas, nesting one function within another means 

using one function as an argument of another function. In modern versions 

of Excel 2016, 2013, 2010 and 2010, you can use up to 64 nested functions. 

In older versions of Excel 2003 and lower, only up to 7 levels of functions 

are allowed. 

 

Here is a very simple example of a nested Excel formula that includes the 

SUM function to find the total, and ROUND function to round that number 

to the nearest integer (0 decimal places) 

 

 
 

=ROUND(SUM(B2:B6),0) 

 

Of all Excel functions, IF is nested more often than all others. As you 

probably know, the IF function is used to evaluate a specified condition and 

return one value when condition is met, and another value when the condition 

is not met. However, quote often you have to deal with situations where there 

are more than two possible outcomes. And if this case, you can write several 

IF functions and nest them into each other 
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Array formulas in Excel 

 

Array formulas in Excel are advanced aerobatics. A single Excel array 

formula can perform thousands of calculations and replace hundreds of usual 

formulas. Learning array formulas certainly requires some time and effort, 

but it's worth it. 

 

Since this tutorial is purposed for beginners, I won't intimidate you by the 

definitions of array constants and complex multi-line formulas. I'll show just 

one very simple example of an Excel array formula that demonstrates what 

they are capable for. 

 

Supposing you have 2 columns of numbers, column A and B. And you want 

to know how many times column B is greater than or equal to column A when 

a value in column B is greater than 0. 

 

This task requires comparing two ranges and you can do this by using the 

following array formula: 

=SUM((B2:B10>=A2:A10) * (B2:B10>0)) 

 

 
 

 

Note. To enter an Excel array formula correctly, you have to 

press Ctrl+Shift+Enter instead of conventional Enter stroke. 
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Excel user defined functions 

 

Although Microsoft Excel has hundreds of built in functions, you still may 

find yourself faced with a challenge for which no predefined Excel function 

exists. In this case, you can create that function yourself...  

 

Such custom functions are called User Defined Functions (UDFs), and they 

are especially useful for advanced mathematic or engineering calculations. 

Like macros, user defined functions are written in VBA (Visual Basic for 

Applications).  

 

Absolute, relative and mixed cell references in Excel formulas 

There exist 3 types of cell references in Excel: absolute ($A$1), relative (A1) 

and mixed ($A1 or A$1). All three of the above references refer to the same 

cell, and the dollar sign ($) is used only for one purpose - it tells Microsoft 

Excel whether to change or not to change cell references when the formula is 

moved or copied to other cells. 

 

Absolute cell reference ($A$1) - the $ sign before the row and column 

coordinates makes a reference static, and lets you copy a formula without 

changing references. 

 

Relative cell reference (A1) - a cell reference with no $ sign changes based 

on relative position of rows and columns in a spreadsheet. 

 

Mixed cell reference - can be of 2 types 

 

• Absolute column and relative row ($A1) - the $ sign in front of the 

column letter locks the reference to the specified column, so the column 

never changes. The relative row reference, without the dollar sign, 

changes depending on the row to which the formula is copied. 

• Relative column and absolute row (A$1) - the row's reference locked 

by $ doesn't change, and the column's reference does. 

 

The following image shows how different reference types work in practice. 
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iv. Information Function  

 

A. CELL Function 

 

The CELL function returns information about the formatting, location, or 

contents of a cell. For example, if you want to verify that a cell contains a 

numeric value instead of text before you perform a calculation on it, you can 

use the following formula 

 

=IF(CELL("type",A1)="v",A1*2,0) 

 

This formula calculates A1*2 only if cell A1 contains a numeric value, and 

returns 0 if A1 contains text or is blank. 
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Note: Formulas that use CELL have language-specific argument values and 

will return errors if calculated using a different language version of Excel. For 

example, if you create a formula containing CELL while using the Czech 

version of Excel, that formula will return an error if the workbook is opened 

using the French version.  If it is important for others to open your workbook 

using different language versions of Excel, consider either using alternative 

functions or allowing others to save local copies in which they revise the CELL 

arguments to match their language. 

Syntax: CELL(info_type, [reference]) 

 

The CELL function syntax has the following arguments 

 

Argument Description 

info_type    

Required 

A text value that specifies what type of cell information 

you want to return. The following list shows the possible 

values of the Info_type argument and the corresponding 

results. 

reference     

Optional 

The cell that you want information about. 

If omitted, the information specified in the info_type 

argument is returned for cell selected at the time of 

calculation. If the reference argument is a range of cells, 

the CELL function returns the information for active cell 

in the selected range. 

Important: Although technically reference is optional, 

including it in your formula is encouraged, unless you 

understand the effect its absence has on your formula 

result and want that effect in place. Omitting the reference 

argument does not reliably produce information about a 

specific cell, for the following reasons: 

▪ In automatic calculation mode, when a cell is 

modified by a user the calculation may be triggered 

before or after the selection has progressed, 

depending on the platform you're using for 

Excel.  For example, Excel for Windows currently 

triggers calculation before selection changes, 

but Excel for the web triggers it afterward. 
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Argument Description 

▪ When Co-Authoring with another user who makes 

an edit, this function will report your active cell 

rather than the editor's. 

▪ Any recalculation, for instance pressing F9, will 

cause the function to return a new result even 

though no cell edit has occurred. 

 

info_type values 

 

The following list describes the text values that can be used for the info_type 

argument. These values must be entered in the CELL function with quotes (" 

"). 

 

info_type Returns 

"address" Reference of the first cell in reference, as text.  

"col" Column number of the cell in reference. 

"color" The value 1 if the cell is formatted in color for negative 

values; otherwise returns 0 (zero). 

Note: This value is not supported in Excel for the web, 

Excel Mobile, and Excel Starter. 

"contents" Value of the upper-left cell in reference; not a formula. 

"filename" Filename (including full path) of the file that contains 

reference, as text. Returns empty text ("") if the 

worksheet that contains reference has not yet been 

saved. 

Note: This value is not supported in Excel for the web, 

Excel Mobile, and Excel Starter. 

"format" Text value corresponding to the number format of the 

cell. The text values for the various formats are shown 

in the following table. Returns "-" at the end of the text 

value if the cell is formatted in color for negative values. 

Returns "()" at the end of the text value if the cell is 

formatted with parentheses for positive or all values. 
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info_type Returns 

Note: This value is not supported in Excel for the web, 

Excel Mobile, and Excel Starter. 

"parentheses" The value 1 if the cell is formatted with parentheses for 

positive or all values; otherwise returns 0. 

Note: This value is not supported in Excel for the web, 

Excel Mobile, and Excel Starter. 

"prefix" Text value corresponding to the "label prefix" of the 

cell. Returns single quotation mark (') if the cell 

contains left-aligned text, double quotation mark (") if 

the cell contains right-aligned text, caret (^) if the cell 

contains centered text, backslash (\) if the cell contains 

fill-aligned text, and empty text ("") if the cell contains 

anything else. 

Note: This value is not supported in Excel for the web, 

Excel Mobile, and Excel Starter. 

"protect" The value 0 if the cell is not locked; otherwise returns 1 

if the cell is locked. 

Note: This value is not supported in Excel for the web, 

Excel Mobile, and Excel Starter. 

"row" Row number of the cell in reference. 

"type" Text value corresponding to the type of data in the cell. 

Returns "b" for blank if the cell is empty, "l" for label if 

the cell contains a text constant, and "v" for value if the 

cell contains anything else. 

"width" Returns an array with 2 items. 

The 1st item in the array is the column width of the cell, 

rounded off to an integer. Each unit of column width is 

equal to the width of one character in the default font 

size. 

The 2nd item in the array is a Boolean value, the value 

is TRUE if the column width is the default or FALSE if 

the width has been explicitly set by the user.  

Note: This value is not supported in Excel for the web, 

Excel Mobile, and Excel Starter. 
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CELL format codes 

 

The following list describes the text values that the CELL function returns 

when the Info_type argument is "format" and the reference argument is a cell 

that is formatted with a built-in number format. 

 

 

If the Excel format is The CELL function returns 

General "G" 

0 "F0" 

#,##0 ",0" 

0.00 "F2" 

#,##0.00 ",2" 

$#,##0_);($#,##0) "C0" 

$#,##0_);[Red]($#,##0) "C0-" 

$#,##0.00_);($#,##0.00) "C2" 

$#,##0.00_);[Red]($#,##0.00) "C2-" 

0% "P0" 

0.00% "P2" 

0.00E+00 "S2" 

# ?/? or # ??/?? "G" 

m/d/yy or m/d/yy h:mm or 

mm/dd/yy 

"D4" 

d-mmm-yy or dd-mmm-yy "D1" 

d-mmm or dd-mmm "D2" 

mmm-yy "D3" 

mm/dd "D5" 

h:mm AM/PM "D7" 

h:mm:ss AM/PM "D6" 

h:mm "D9" 

h:mm:ss "D8" 

Note: If the info_type argument in the CELL function is "format" and you later 

apply a different format to the referenced cell, you must recalculate the 

worksheet (press F9) to update the results of the CELL function. 

Examples 
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B. ERROR.TYPE function 

 

Returns a number corresponding to one of the error values in Microsoft Excel 

or returns the #N/A error if no error exists. You can use ERROR.TYPE in an 

IF function to test for an error value and return a text string, such as a message, 

instead of the error value. 

 

Syntax 

 

ERROR.TYPE(error_val) 

 

The ERROR.TYPE function syntax has the following arguments 

▪ Error_val    Required. The error value whose identifying number you 

want to find. Although error_val can be the actual error value, it will 

usually be a reference to a cell containing a formula that you want to test. 

 

If error_val is ERROR.TYPE returns 

#NULL! 1 

#DIV/0! 2 

#VALUE! 3 

#REF! 4 

#NAME? 5 

#NUM! 6 

#N/A 7 

#GETTING_DATA 8 

Anything else #N/A 

 

Example 

 

Copy the example data in the following table, and paste it in cell A1 of a new 

Excel worksheet. For formulas to show results, select them, press F2, and then 

press Enter. If you need to, you can adjust the column widths to see all the data. 
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Data 
  

#NULL! 
  

#DIV/0! 
  

Formula Descri

ption 

Re

sul

t 

=ERROR.TYPE(A2) Numbe

r of the 

#NUL

L! 

Error(1

). 

1 

=IF(ERROR.TYPE(A3)<3,CHOOSE(ERROR.T

YPE(A3),"Ranges do not intersect","The divisor 

is zero")) 

Checks 

cell A3 

to see 

whethe

r the 

cell 

contain

s either 

the 

#NUL

L! error 

value 

or the 

#DIV/0

! error 

value. 

If it 

does, 

then 

the 

number 

for the 

error 

value is 

used in 

the 

Th

e 

div

isor 

is 

zer

o 
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Data 
  

CHOO

SE 

worksh

eet 

functio

n to 

display 

one of 

two 

messag

es; 

otherwi

se, the 

#N/A 

error 

value is 

returne

d. 

 

C. INFO function 

 

Returns information about the current operating environment. 

 

Syntax 

 

INFO(type_text) 

The INFO function syntax has the following arguments: 

▪ Type_text    Required. Text that specifies what type of information you 

want returned. 

 

Type_text Returns 

"directory" Path of the current directory or folder specified in the 

Excel option, At startup, open all files 

in (Select File > Options > Advanced > General). 

"numfile" Number of worksheets in the open workbooks. 

"origin" Returns the absolute cell reference of the top and 

leftmost cell visible in the window, based on the current 
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Type_text Returns 

scrolling position, as text prepended with "$A:". This 

value is intended for for Lotus 1-2-3 release 3.x 

compatibility. The actual value returned depends on the 

current reference style setting. Using D9 as an example, 

the return value would be: 

▪ A1 reference style     "$A:$D$9". 

▪ R1C1 reference style    "$A:R9C4" 

"osversion" Current operating system version, as text. 

"recalc" Current recalculation mode; returns "Automatic" or 

"Manual". 

"release" Version of Microsoft Excel, as text. 

"system" Name of the operating environment: 

Macintosh = "mac" 

Windows = "pcdos" 

Important: In previous versions of Microsoft Excel, the "memavail", 

"memused", and "totmem" type_text values, returned memory information. 

These type_text values are no longer supported and now return a #N/A error 

value. 

Example 

Copy the example formulas in the following table, and paste them in a new 

Excel worksheet.  

 

Formula Description Result 

=INFO("numfile") Number of 

worksheets in 

open 

workbooks 

a number indicating how many 

sheets are in the currently open 

workbooks 

=INFO("recalc") Recalculation 

mode for the 

workbook. 

"Automatic" or "Manual" 

depending on the current state 

of your calculation options. 

 

D. IS functions 

 

 

Each of these functions, referred to collectively as the IS functions, checks the 

specified value and returns TRUE or FALSE depending on the outcome. For 
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example, the ISBLANK function returns the logical value TRUE if the value 

argument is a reference to an empty cell; otherwise it returns FALSE. 

 

You can use an IS function to get information about a value before performing 

a calculation or other action with it. For example, you can use 

the ISERROR function in conjunction with the IF function to perform a 

different action if an error occurs 

= IF( ISERROR(A1), "An error occurred.", A1 * 2) 

 

This formula checks to see if an error condition exists in A1. If so, 

the IF function returns the message "An error occurred." If no error exists, 

the IF function performs the calculation A1*2. 

Syntax 

ISBLANK(value) 

ISERR(value) 

ISERROR(value) 

ISLOGICAL(value) 

ISNA(value) 

ISNONTEXT(value) 

ISNUMBER(value) 

ISREF(value) 

ISTEXT(value) 

 

The IS function syntax has the following argument: 

▪ value    Required. The value that you want tested. The value argument 

can be a blank (empty cell), error, logical value, text, number, or 

reference value, or a name referring to any of these. 

 

Function Returns TRUE if 

ISBLANK Value refers to an empty cell. 

ISERR Value refers to any error value except #N/A. 

ISERROR Value refers to any error value (#N/A, #VALUE!, #REF!, 

#DIV/0!, #NUM!, #NAME?, or #NULL!). 

ISLOGICAL Value refers to a logical value. 

ISNA Value refers to the #N/A (value not available) error value. 

ISNONTEXT Value refers to any item that is not text. (Note that this function 

returns TRUE if the value refers to a blank cell.) 
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Function Returns TRUE if 

ISNUMBER Value refers to a number. 

ISREF Value refers to a reference. 

ISTEXT Value refers to text. 

 

Remarks 

 

▪ The value arguments of the IS functions are not converted. Any numeric 

values that are enclosed in double quotation marks are treated as text. For 

example, in most other functions where a number is required, the text 

value "19" is converted to the number 19. However, in the 

formula ISNUMBER("19"), "19" is not converted from a text value to 

a number value, and the ISNUMBER function returns FALSE. 

▪ The IS functions are useful in formulas for testing the outcome of a 

calculation. When combined with the IF function, these functions 

provide a method for locating errors in formulas (see the following 

examples). 

 

Examples 

 

 

Example 1 

 

Copy the example data in the following table, and paste it in cell A1 of a new 

Excel worksheet. For formulas to show results, select them, press F2, and then 

press Enter. If you need to, you can adjust the column widths to see all the data. 

 

Formula Description Result 

=ISLOGICAL(TRUE) Checks whether TRUE is a 

logical value 

TRUE 

=ISLOGICAL("TRUE") Checks whether "TRUE" is a 

logical value 

FALSE 

=ISNUMBER(4) Checks whether 4 is a number TRUE 

=ISREF(G8) Checks whether G8 is a valid 

reference 

TRUE 
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Formula Description Result 

=ISREF(XYZ1) Checks whether XYZ1 is a 

valid reference 

FALSE 

 

Example 2 

 

Copy the example data in the following table, and paste it in cell A1 of a new 

Excel worksheet. For formulas to show results, select them, press F2, and then 

press Enter. If you need to, you can adjust the column widths to see all the data. 

 

Data 
  

Gold 
  

Region1 
  

#REF! 
  

330.92 
  

#N/A 
  

Formula Description Result 

=ISBLANK(A2) Checks whether cell A2 is blank. FALSE 

=ISERROR(A4) Checks whether the value in cell A4, 

#REF!, is an error. 

TRUE 

=ISNA(A4) Checks whether the value in cell A4, 

#REF!, is the #N/A error. 

FALSE 

=ISNA(A6) Checks whether the value in cell A6, 

#N/A, is the #N/A error. 

TRUE 

=ISERR(A6) Checks whether the value in cell A6, 

#N/A, is an error. 

FALSE 

=ISNUMBER(A5) Checks whether the value in cell A5, 

330.92, is a number. 

TRUE 

=ISTEXT(A3) Checks whether the value in cell A3, 

Region1, is text. 

TRUE 

 

E. Lookup Functions 

The LOOKUP function in Excel is used to search for a value in a one-row or 

one-column range and return a value from the same position in another row or 
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column. It's a simple way to perform lookups when you don't need an exact 

match, but rather a "rough match" or an approximate match. 

 

While doing financial analysis, if we wish to compare two rows or columns, 

we can use the LOOKUP function. It is designed to handle the simplest cases 

of vertical and horizontal lookup. 

 

The more advanced versions of the LOOKUP function are HLOOKUP and 

VLOOKUP. 

  

Formula (Vector) 

 

There are two forms of Lookup: Vector and Array. 

 

The vector form of the LOOKUP function will search one row or one column 

of data for a specified value and then get the data from the same position in 

another row or column. 

The formula for the function is as follows: 

=LOOKUP(lookup_value, lookup_vector, [result_vector]) 

 

It uses the following arguments 

 

1. Lookup_value (required function) – This is the value that we will be 

searching. It can be a logical value of TRUE or FALSE, reference to a 

cell, number, or text. 

2. Lookup_vector (required function) – This is the one-dimensional data 

that we wish to search. Remember, we need to sort it in ascending order. 

3. Result_vector – An optional one-dimensional list of data from which we 

want to return a value. If supplied, the [result_vector] must be the same 

length as the lookup_vector. If the [result_vector] is omitted, the result 

is returned from the lookup_vector. 

 

The array form of LOOKUP looks in the first row or column of an array for 

the specified value and returns a value from the same position in the last row 

or column of the array. We need to use this form of LOOKUP when the values 

that we want to match are in the first row or column of the array. 

 

Formula (Array) LOOKUP Function 

= LOOKUP(lookup_value, array) 
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The arguments are as follows: 

1. Lookup_value (required argument) – This is a value that we are 

searching for. 

2. Array (required argument) – A range of cells that contains text, 

numbers, or logical values that we want to compare with the 

lookup_value. 

 

How to use the LOOKUP Function in Excel? 

As a worksheet function, the LOOKUP Function can be entered as part of a 

formula in a cell of a worksheet. To understand the uses of this function, let us 

consider a few examples: 

 

Example 1 

Assume we are given a list of products, color, order_id, and quantity. We want 

a dashboard where we put the product and then we instantly get the quantity. 

 

 
 

The formula to use will be 

 

 
 

The result we get is 
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Example 2 

Suppose we are in the business of giving loans and we offer different interest 

rates based on the amount borrowed. We are given the data below 
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The formula to use will be 

 

 
 

 

We will get the following result 

 

 
 

 

Things to remember about the LOOKUP Function 

 

1. #N/A error – Occurs when the Lookup function fails to find the closest 

match to the supplied lookup_value. This can occur if either: 

1. The smallest value in the lookup_vector (or first column/row of 

the array) is greater than the lookup_value provided; or 
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2. The lookup_vector (or first column/row of the array) is not in 

ascending order. 

2. #REF! error – Occurs if the formula is attempting to reference cells that 

are non-existent. This can be caused by either: 

1. Cells being deleted after the Lookup function has been entered. 

2. Relative references in the Lookup function that have become 

invalid when the functions have been copied to other cells. 

 

F. Date and Time Functions 

 

a. Excel DATE function 

 

DATE(year, month, day) returns a serial number of a date based on the 

year, month and day values that you specify. 

 

When it comes to working with dates in Excel, DATE is the most 

essential function to understand. The point is that other Excel date 

functions not always can recognize dates entered in the text format. So, 

when performing date calculations in Excel, you'd better supply dates 

using the DATE function to ensure the correct results. 

 

Here are a few Excel DATE formula examples: 

=DATE(2015, 5, 20) - returns a serial number corresponding to 20-May-

2015. 

=DATE(YEAR(TODAY()), MONTH(TODAY()), 1) - returns the first 

day of the current year and month. 

=DATE(2015, 5, 20)-5 - subtracts 5 days from May 20, 2015. 

 

 
 

b. Excel TODAY function 

 

The TODAY() function returns today's date, exactly as its name 

suggests. 



 

108 
 

TODAY is arguably one of the easiest Excel functions to use because it 

has no arguments at all. Whenever you need to get today's date in Excel, 

enter the following formula is a cell: 

 

=TODAY() 

 

Apart from this obvious use, the Excel TODAY function can be part of 

more complex formulas and calculations based on today's date. For 

example, to add 7 days to the current date, enter the following formula 

in a cell: 

 

=TODAY()+7 

 

To add 30 weekdays to today's date excluding weekend days, use this 

one: 

=WORKDAY(TODAY(), 30) 

 

 
 

 

c. Excel NOW function 

 

NOW() function returns the current date and time. As well as TODAY, 

it does not have any arguments. If you wish to display today's date and 

current time in your worksheet, simply put the following formula in a 

cell 

 

=NOW() 

 

Note. As well as TODAY, Excel NOW is a volatile function that 

refreshes the returned value every time the worksheet is recalculated. 

Please note, the cell with the NOW() formula does not auto update in 

real-time, only when the workbook is reopened or the worksheet is 

recalculated. To force the spreadsheet to recalculate, and consequently 

get your NOW formula to update its value, press either Shift+F9 to 
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recalculate only the active worksheet or F9 to recalculate all open 

workbooks. 

 

d. Excel DATEVALUE function 

 

DATEVALUE(date_text) converts a date in the text format to a 

serial number that represents a date. 

 

The DATEVALUE function understands plenty of date formats as 

well as references to cells that contain "text dates". DATEVALUE 

comes in really handy to calculate, filter or sort dates stored as text 

and convert such "text dates" to the Date format. 

 

A few simple DATEVALUE formula examples follow below 

 

=DATEVALUE("20-may-2015") 

=DATEVALUE("5/20/2015") 

=DATEVALUE("may 20, 2015") 

 

 
 

e. Excel TEXT function 

 

In the pure sense, the TEXT function cannot be classified as one of Excel 

date functions because it can convert any numeric value, not only dates, 

to a text string. 

With the TEXT(value, format_text) function, you can change the dates 

to text strings in a variety of formats, as demonstrated in the following 

screenshot. 
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f. Excel DAY function 

 

DAY(serial_number) function returns a day of the month as an integer 

from 1 to 31. 

Serial_number is the date corresponding to the day you are trying to 

get. It can be a cell reference, a date entered by using the DATE function, 

or returned by other formulas. 

 

Here are a few formula examples 

 

=DAY(A2) - returns the day of the month from a date in A2 

=DAY(DATE(2015,1,1)) - returns the day of 1-Jan-2015 

=DAY(TODAY()) - returns the day of today's date 

 

 
 

g. Excel MONTH function 

 

MONTH(serial_number) function in Excel returns the month of a 

specified date as an integer ranging from 1 (January) to 12 (December). 

For example: 

=MONTH(A2) - returns the month of a date in cell A2. 

=MONTH(TODAY()) - returns the current month. 

 

For the detail explanation of the MONTH function's syntax and plenty 

more formula examples, please check out the following tutorial: Using 

the MONTH function in Excel. 

https://www.ablebits.com/office-addins-blog/excel-month-eomonth-functions/
https://www.ablebits.com/office-addins-blog/excel-month-eomonth-functions/
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h. Excel YEAR function 

 

YEAR(serial_number) returns a year corresponding to a given date, as 

a number from 1900 to 9999. 

The Excel YEAR function is very straightforward and you will hardly 

run into any difficulties when using it in your date calculations: 

=YEAR(A2) - returns the year of a date in cell A2. 

=YEAR("20-May-2015") - returns the year of the specified date. 

=YEAR(DATE(2015,5,20)) - a more reliable method to get the year of 

a given date. 

=YEAR(TODAY()) - returns the current year. 

 

 
 

i. Excel EOMONTH function 

 

EOMONTH(start_date, months) function returns the last day of the 

month a given number of months from the start date. 

Like most of Excel date functions, EOMONTH can operate on dates 

input as cell references, entered by using the DATE function, or results 

of other formulas. 

 

A positive value in the months argument adds the corresponding 

number of months to the start date, for example: 

=EOMONTH(A2, 3) - returns the last day of the month, 3 

months after the date in cell A2. 

A negative value in the months argument subtracts the corresponding 

number of months from the start date: 

=EOMONTH(A2, -3) - returns the last day of the month, 3 

months before the date in cell A2. 

A zero in the months argument forces the EOMONTH function to return 

the last day of the start date's month: 



 

112 
 

=EOMONTH(DATE(2015,4,15), 0) - returns the last day in April, 

2015. 

To get the last day of the current month, enter the TODAY function in 

the start_date argument and 0 in months: 

=EOMONTH(TODAY(), 0) 

 

 
 

j. Excel WEEKDAY function 

 

WEEKDAY(serial_number,[return_type]) function returns the day of 

the week corresponding to a date, as a number from 1 (Sunday) to 7 

(Saturday). 

• Serial_number can be a date, a reference to a cell containing a 

date, or a date returned by some other Excel function. 

• Return_type (optional) - is a number that determines which day 

of the week shall be considered the first day. 

 

And here are a few WEEKEND formula examples 

 

=WEEKDAY(A2) - returns the day of the week corresponding to a date 

in cell A2; the 1st day of the week is Sunday (default). 

=WEEKDAY(A2, 2) - returns the day of the week corresponding to a 

date in cell A2; the week begins on Monday. 

 

=WEEKDAY(TODAY()) - returns a number corresponding to today's 

day of the week; the week begins on Sunday. 

 

https://www.ablebits.com/office-addins-blog/excel-date-functions/#TODAY
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k. Excel DATEDIF function 

 

DATEDIF(start_date, end_date, unit) function is specially designed 

to calculate the difference between two dates in days, months or years. 

Which time interval to use for calculating the date difference depends on 

the letter you enter in the last argument: 

=DATEDIF(A2, TODAY(), "d") - calculates the number 

of days between the date in A2 and today's date. 

=DATEDIF(A2, A5, "m") - returns the number of complete 

months between the dates in A2 and B2. 

=DATEDIF(A2, A5, "y") - returns the number of complete 

years between the dates in A2 and B2. 

 

 
 

 

l. Excel WEEKNUM function 

 

WEEKNUM(serial_number, [return_type]) - returns the week 

number of a specific date as an integer from 1 to 53. 

For example, the below formula returns 1 because the week containing 

January 1 is the first week in the year. 

 

=WEEKNUM("1-Jan-2015") 

 

Excel EDATE function 
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EDATE(start_date, months) function returns the serial number of the 

date that is the specified number of months before or after the start date. 

For example: 

 

=EDATE(A2, 5) - adds 5 months to the date in cell A2. 

=EDATE(TODAY(), -5) - subtracts 5 months from today's date. 

 

 

m. Excel YEARFRAC function 

 

YEARFRAC(start_date, end_date, [basis]) function calculates the 

proportion of the year between 2 dates. 

 

n. Excel WORKDAY function 

 

WORKDAY(start_date, days, [holidays]) function returns a date N 

workdays before or after the start date. It automatically excludes 

weekend days from calculations as well as any holidays that you specify. 

This function is very helpful for calculating milestones and other 

important events based on the standard working calendar. 

For example, the following formula adds 45 weekdays to the start date 

in cell A2, ignoring holidays in cells B2:B8: 

 

=WORKDAY(A2, 45, B2:B85) 

 

o. Excel WORKDAY.INTL function 

 

WORKDAY.INTL(start_date, days, [weekend], [holidays]) is a more 

powerful variation of the WORKDAY function introduced in Excel 

2010. 

WORKDAY.INTL allows calculating a date N number of workdays in 

the future or in the past with custom weekend parameters. 

For example, to get a date 20 workdays after the start date in cell A2, 

with Monday and Sunday counted as weekend days, you can use either 

of the following formulas 
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=WORKDAY.INTL(A2, 20, 2, 7) 

or 

=WORKDAY.INTL(A2, 20, "1000001") 

 

Of course, it might be difficult to grasp the essence from this short 

explanation, but more formula examples illustrated with screenshots will 

make things really easy: 

WORKDAY.INTL - calculating workdays with custom weekends 

Excel NETWORKDAYS function 

NETWORKDAYS(start_date, end_date, [holidays]) function returns 

the number of weekdays between two dates that you specify. It 

automatically excludes weekend days and, optionally, the holidays. 

 

For example, the following formula calculates the number of whole 

workdays between the start date in A2 and end date in B2, ignoring 

Saturdays and Sundays and excluding holidays in cells 

C2:C5:=NETWORKDAYS(A2, B2, C2:C5) 

 

p. Excel NETWORKDAYS.INTL function 

 

NETWORKDAYS.INTL(start_date, end_date, [weekend], 

[holidays]) is a more  

powerful modification of the NETWORKDAYS function available in 

Excel 2010 and later. It also returns the number of weekdays between 

two dates, but lets you specify which days should be counted as 

weekends. 

 

Here is a basic NETWORKDAYS formula: =NETWORKDAYS(A2, 

B2, 2, C2:C5) 

 

The formula calculates the number of workdays between the date in A2 

(start_date) and the date in B2 (end_date), excluding the weekend days 

Sunday and Monday (number 2 in the weekend parameter), and ignoring 

holidays in cells C2:C5. 
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Self-Check Sheet - 2: Use Formulas and functions 

 

1. Identify the category that is NOT a type of Excel function: 

 

a) Basic (SUM, AVERAGE, COUNT, MAX, MIN) 

b) Statistical (functions to analyze data distribution) 

c) Text (functions to manipulate text data) 

d) Image 

 

2. What information does the "Arguments" section of a function provide? 

 

a) The function name itself 

b) The values or cell references used for calculations 

c) The format of the output (e.g., currency, percentage) 

d) A comment explaining the function's purpose 

 

3. How do Excel functions benefit users compared to manual calculations? 

 

a) They increase complexity. 

b) They automate tasks and reduce errors. 

c) They can only handle small datasets. 

d) They make sharing formulas difficult. 

 

4. Which logical function returns TRUE if exactly one of its arguments is TRUE? 

 

a) AND (requires all arguments to be TRUE) 

b) OR 

c) XOR (requires an odd number of TRUE arguments) 

d) NOT (inverts the logical value of a single argument) 

 

5. How can you display a number as a currency value using the TEXT function? 

 

a) There is no TEXT function for currency formatting. 

b) Use the format code "$0.00" within the TEXT function. 

c) Apply currency formatting directly to the cell. 

d) Both B and C are correct. 
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6. What is the key difference between the IF and AND functions? 

 

a) IF allows multiple conditions, while AND requires a single condition. 

b) AND formats cells, while IF performs calculations. 

c) IF returns different outputs based on the test, while AND always returns TRUE or FALSE. 

d) There is no difference; they perform the same function. 
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Answer Key - 2: Use Formulas and functions 

 

d) Image 

b) The values or cell references used for calculations 

b) They automate tasks and reduce errors. 

b) OR 

d) Both B and C are correct. (TEXT function with "$0.00" format or direct formatting) 

c) IF can return different outputs based on the test result, while AND always returns TRUE or 

FALSE. 
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Job Sheet-2: Create a worksheet using Logical, Text and Financial 

Function 

Instructions: 

1. Create a New Workbook: Open Microsoft Excel and create a new workbook. 

2. Sample Data: For each section, you will need sample data in your worksheet. This 

could be a list of sales figures, customer information, inventory details, or any data 

relevant to the practiced functions. 

Section A: Logical Functions 

• Task 1: Create a formula using the IF function to determine if a product sold more 

than 100 units. Display "High Sales" if true, and "Low Sales" if false. 

• Task 2: Combine multiple conditions using the AND and/or OR functions. For 

example, identify customers who live in California (CA) and have spent more than 

$500. 

• Task 3 (Bonus): Explore the COUNTIF and SUMIF functions. Count the number of 

items with a specific value (e.g., "Out of Stock") or calculate the total sales amount 

for a particular product category. 

Section B: Text Functions 

• Task 1: Extract specific text from a cell using the LEFT and/or RIGHT functions. 

For example, extract the first five characters of a product code. 

• Task 2: Combine text from different cells using the CONCATENATE function. For 

example, create a full customer name from separate first and last name columns. 

• Task 3 (Bonus): Explore the UPPER and LOWER functions to convert text to 

uppercase or lowercase. You can also try the CLEAN function to remove unwanted 

characters from text data. 

Section C: Financial Functions 

• Task 1: Calculate loan payments using the PMT function. Specify the loan amount, 

interest rate, and term (number of payments) to determine the monthly payment 

amount. 

• Task 2: Calculate the future value of an investment using the FV function. Specify 

the initial investment amount, interest rate, and number of periods to determine the 

future value. 

• Task 3 (Bonus): Explore the IRR and NPV functions. The IRR function calculates 

the internal rate of return for an investment, while the NPV function determines the 

net present value of a series of cash flows. 

Deliverable: 

• A completed Excel workbook with three separate worksheets demonstrating the use 

of Logical, Text, and Financial functions. 

• Each task should be clearly labeled within the corresponding worksheet. 
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Specification Sheet-2: Create a worksheet using Logical, Text and 

Financial Function 
 

 

Necessary Tools  
 

Sl. No Name of Tools Specification Unit Quantity 

2      

 

Necessary Equipment 
 

Sl. No Name of Equipment Specification Unit Quantity 

3.  Computer  As Need No. 01 

4.  Spreadsheet Software  As Need No. 01 
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Learning Outcome 3: Making Charts  

 

Assessment Criteria 

 

1. Data can be accessed. 

2. The type of chart can be selected. 

3. A chart can be created  

4. The chart can be formatted  

5. The chart can be presented  

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

Contents 

1. Data Access 

o Chart Type 

o Pie Chart 

o Bar Chart 

o Line Chart 

o Area Chart 

o X Y Chart 

2. Chart Creation 

3. Chart Formatting 

4. Chart Presentation 

Activities/job/Task 1. Create a worksheet using Charts 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

Assessment methods may include but not limited to 

1. Written Test 

2. Demonstration 

3. Oral Questioning 

4. Portfolio   
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Learning Experience 3: Make Charts 

 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

1. Trainee will ask the instructor about 

about the learning materials 

1. Instructor will provide the learning materials 

‘Perform Making Charts’ 

2. Read the Information sheet 

and complete the Self Checks 

& Check answer sheets on 

“Make Charts” 

2. Read Information sheet 3: Perform Making 

Chart 

3. Answer Self-check 3: Perform Making Chart 

4. Check your answer with Answer key 3: 

Perform Making Chart 

3. Read the Job/Task Sheet and 

Specification Sheet and 

perform job/Task 

5. Job/Task Sheet and Specification Sheet  

Job Sheet-3: Create a worksheet using 

Charts 
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Information Sheet 3: Making Charts 

 
 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 

 

3.1. Data can be accessed. 

3.2. The type of chart can be selected. 

3.3. A chart can be created  

3.4. The chart can be formatted  

3.5. The chart can be presented 

 

3.1, 3.2, 3.3:  Data access, Type of of chart select and create  

 

When you create a chart in an Excel worksheet, a Word document, or a PowerPoint 

presentation, you have a lot of options. Whether you’ll use a chart that’s recommended 

for your data, one that you’ll pick from the list of all charts, or one from our selection 

of chart templates, it might help to know a little more about each type of chart. 

 

Types of Charts in MS Excel 

Different scenarios require different types of charts. Towards this end, Excel provides 

a number of chart types that you can work with. The type of chart that you choose 

depends on the type of data that you want to visualize. To help simplify things for 

the users, Excel 2013 and above has an option that analyses your data and makes a 

recommendation of the chart type that you should use. 

The following table shows some of the most commonly used Excel charts and when 

you should consider using them. 
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S/

N 

CHAR

T 

TYPE 

WHEN 

SHOULD 

I USE IT? 

EXAMPLE 

1 Pie 

Chart 

When you 

want to 

quantify 

items and 

show them 

as 

percentage

s. 
 

2 Bar 

Chart 

When you 

want to 

compare 

values 

across a 

few 

categories. 

The values 

run 

horizontall

y  

3 Colum

n chart 

When you 

want to 

compare 

values 

across a 

few 

categories. 

The values 

run 

vertically 

 

https://www.guru99.com/images/5-2015/050215_0900_Visualizing1.png
https://www.guru99.com/images/5-2015/050215_0900_Visualizing2.png
https://www.guru99.com/images/5-2015/050215_0900_Visualizing3.png
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4 Line 

chart 

When you 

want to 

visualize 

trends 

over a 

period of 

time i.e. 

months, 

days, 

years, etc. 

 

5 Combo 

Chart 

When you 

want to 

highlight 

different 

types of 

informatio

n 

 

 

 

The importance of charts 

 

• Allows you to visualize data graphically 

• It’s easier to analyse trends and patterns using charts in MS Excel 

• Easy to interpret compared to data in cells 

 

Step by step example of creating charts in Excel 

In this tutorial, we are going to plot a simple column chart in Excel that will display 

the sold quantities against the sales year. Below are the steps to create chart in MS 

Excel: 

• Open Excel 

• Enter the data from the sample data table above 

• Your workbook should now look as follows 

 

https://www.guru99.com/images/5-2015/050215_0900_Visualizing4.png
https://www.guru99.com/images/5-2015/050215_0900_Visualizing5.png
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To get the desired chart you have to follow the following steps 

 

 

 

▪ Select the data you want to represent in graph 

▪ Click on INSERT tab from the ribbon 

▪ Click on the Column chart drop down button 

▪ Select the chart type you want 

 

https://www.guru99.com/images/5-2015/050215_0900_Visualizing6.png
https://www.guru99.com/images/5-2015/050215_0900_Visualizing7.png
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3.4 and 3.5: format the chart and present  

 

A. Formatting the chart title 

 

The chart title can be formatted to change color, pattern, typeface, size, and alignment 

using the Format Chart Title dialog box. 

 

To format the chart title 

Select the chart title. 
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Click Format on the Chart toolbar, or double-click the chart title. 

 

 

▪ The Format Chart Title dialog box contains three tabs—Patterns, Font, and 

Alignment—that can be used to format the chart title. 

▪ The Patterns tab lets you define borders and fill colors. 

▪ The Font tab lets you define font, font style, size, and color. 

▪ The Alignment tab lets you define horizontal and vertical cell placement, as well 

as text orientation. 

 

• Click OK to accept the chart title format changes. 

 

B. Formatting the chart legend 

 

The chart legend displays useful information about the chart. Like a roadmap, the 

legend identifies what different colors or objects represent in the chart. The chart 

legend—like the chart title and category axis labels—can be formatted to your liking. 

 

To format the chart legend 

• Press the show/hide legend button on the Chart toolbar to turn on the legend 

display. (This button acts like a toggle by turning the display on or off.) 
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• Click to select the chart legend. 

• Click Format on the Chart toolbar, or double-click the chart legend. 

 

 

 

• The Format Legend dialog box contains three tabs—Patterns, Font, and 

Alignment—that can be used to format the chart title. 

• The Patterns tab lets you define borders and fill colors. 

• The Font tab lets you define font, font style, size, and color. 

• The Placement tab lets you define the location where the legend will appear on 

the chart. 
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• Click OK to accept the chart legend format changes. 

 

C. Formatting the axis labels 

 

In Excel, a graph represents data in two dimensions. The number of items sold in 

January, for example, is data on two dimensions: number of items and month. The 

number of items might be plotted on the Y axis, while the month may be plotted on the 

X axis. The Y axis runs up and down on the graph, while the X axis runs left to right. 

When formatting the axis labels in your chart, you can adjust the numbers on 

the scale of the chart, as well as change font, color, and style. 

 

To format an axis 

• Click anywhere in the axis label you want to edit 
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• Click Format on the Chart toolbar, or double-click the chart axis. 

 

 

 

• The Format Axis dialog box contains three tabs—Patterns, Font, and 

Alignment—that can be used to format the chart title. 

• The Patterns tab lets you define borders and tick marks. 

• The Scale tab lets you define numeric intervals on the value (Y) axis scale. 

• The Font tab lets you define font, font style, size, and color. 

• The Number tab lets you define the format of numbers displayed in the axis. 

• The Alignment tabs let you define text orientation. 
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• Click OK to accept the axis format changes. 

 

D. Changing the data series color 

 

When a chart is created in Excel XP, you'll notice that color is automatically applied to 

the data series. You can keep this format or change it for each data series in the chart. 

Various aspects of each data series can be changed, but you'll probably change the color 

of bars, columns, pie slices, and areas most often. 

 

To change the color of a data series 

 

• Select the data series you want to edit. 
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• Click Format on the Chart toolbar, or double-click the data series. 

 

 

• Use the Format Data Series dialog box to select a new color. 

 

• Click OK to accept the data series color changes. 
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Self-Check Sheet - 3: Making Charts 

 

1. Which of the following is NOT a step mentioned in creating a chart in Excel covered 

in the information sheet? 

a) Selecting the data you want to represent 

b) Highlighting the entire worksheet 

c) Clicking on the Insert tab 

d) Choosing the desired chart type 
 

2. According to the passage, when is a pie chart most suitable for use? 

a) To compare values across categories 

b) To visualize trends over time 

c) To show parts of a whole and their percentages 

d) To highlight different data types in one chart 

 

3. What can be formatted using the Font tab in the formatting options for charts in 

Excel? 

a) Data values displayed on the chart 

b) The chart borders 

c) The background color of the chart area 

d) Text elements like the title, legend, and axis labels 

 

4. Which of the following is the main purpose of formatting a chart? 

a) To change the underlying data in the worksheet 

b) To improve the readability and visual appeal of the chart 

c) To calculate statistical functions on the data 

d) To insert additional data series into the chart 

 

5. In the context of charts, what does the X-axis typically represent? 

a) The chart title 

b) The data labels for each data point 

c) The categories or groups being compared 

d) The values or quantities being measured 

 

6. Based on the information sheet, which chart type would be best suited to show sales 

figures for each month of the year? 

 

a) Pie Chart 

b) Bar Chart 

c) Column Chart 

d) Line Chart 
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Answer Key - 3: Making Charts 

 

1. Which of the following is NOT a step mentioned in creating a chart in Excel covered 

in the information sheet? 

a) Selecting the data you want to represent 

b) Highlighting the entire worksheet 

c) Clicking on the Insert tab 

d) Choosing the desired chart type 
 

Answer: b) Highlighting the entire worksheet 

 

2. According to the passage, when is a pie chart most suitable for use? 

a) To compare values across categories 

b) To visualize trends over time 

c) To show parts of a whole and their percentages 

d) To highlight different data types in one chart 

 

Answer: c) To show parts of a whole and their percentages 

 

3. What can be formatted using the Font tab in the formatting options for charts in 

Excel? 

a) Data values displayed on the chart 

b) The chart borders 

c) The background color of the chart area 

d) Text elements like the title, legend, and axis labels 

 

Answer: d) Text elements like the title, legend, and axis labels 

 

4. Which of the following is the main purpose of formatting a chart? 

a) To change the underlying data in the worksheet 

b) To improve the readability and visual appeal of the chart 

c) To calculate statistical functions on the data 

d) To insert additional data series into the chart 

 

Answer: b) To improve the readability and visual appeal of the chart 
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5. In the context of charts, what does the X-axis typically represent? 

a) The chart title 

b) The data labels for each data point 

c) The categories or groups being compared 

d) The values or quantities being measured 

 

Answer: c) The categories or groups being compared 

 

6. Based on the information sheet, which chart type would be best suited to show sales 

figures for each month of the year? 

 

a) Pie Chart 

b) Bar Chart 

c) Column Chart 

d) Line Chart 

 

Answer: d) Line Chart 
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Job Sheet-3: Create a worksheet using Charts  

 

Working Procedure:  

 

1. Data Source: Use the provided sample data table below. 

Sample Data Table: 

Month Sales (Units) Revenue Website Visits Average Rating 

Jan 120 $1200 1000 4.2 

Feb 80 $900 800 4.5 

Mar 150 $1500 1200 4.8 

Apr 90 $1080 900 4.3 

May 100 $1100 1100 4.7 

2. Chart Types: This section will explore various chart types to understand their strengths in 

data visualization. 

2.1 Pie Chart: 

• Create a pie chart to visualize the distribution of sales (units) across the months. 

• Label each pie slice with the month and corresponding sales percentage. 

2.2 Bar Chart: 

• Create a stacked bar chart to compare sales (units) and revenue for each month. 

• Label each data series clearly (sales and revenue) and the X-axis with months. 

2.3 Line Chart: 

• Create a line chart to track website visits over time (months). 

• Label the X-axis with months and the Y-axis with website visits. 

• Consider adding data points to the line for a clearer visual representation. 

3. Chart Formatting: 

• Customize the appearance of your charts:  

o Add a descriptive chart title for each chart. 

o Change color schemes for each chart (consider color-blind friendly options). 

o Format chart axes (labels, font size, gridlines, etc.). 

o Add data labels to display specific values within the charts (optional). 
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1. Identify key steps involved in the task revision and update process, aligning with 

the existing flowchart or established procedures. 

2. Include clear and concise instructions for each step, using action verbs. 

3. Consider incorporating optional steps based on specific project needs (e.g., seeking 

external approvals for major revisions). 

4. Organize the checklist in a logical sequence, reflecting the natural flow of the 

revision and update process. 

5. Utilize bullet points and checkboxes for easy completion tracking. 

6. Group related steps under subheadings or sections for better readability. 

7. Use straightforward language that is easy to understand by individuals with 

varying levels of project management experience. 

8. Avoid technical jargon or overly complex sentence structures. 

9. Ensure each checklist item is specific and actionable. 

10. Design the checklist to be adaptable across different project types and 

complexities. 

11. Consider including notes or comments sections for adding project-specific details. 
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Specification Sheet-3: Create a worksheet using Charts 
 

 

Necessary Tools  
 

Sl. No Name of Tools Specification Unit Quantity 

3      

 

Necessary Equipment 
 

Sl. No Name of Equipment Specification Unit Quantity 

5.  Computer  As Need No. 01 

6.  Spreadsheet Software  As Need No. 01 
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Learning Outcome 4: Create table and PIVOT 

 

Assessment Criteria 

 

1. Able to access data according to client requirements. 

2. Able to format data into a table. 

3. Able to design a pivot report according to requirements. 

4. Able to submit the report to the client 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

Contents 

1. Accessing data according to client requirements 

2. Formatting data into a table 

3. Designing a pivot report according to requirements 

4. Submitting the report to the client 

Activities/job/Task 1. Create a Sample PivotTable in Excel 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning 

4. Portfolio   
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Learning Experience 4: Create table and PIVOT 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

1. Trainee will ask the instructor about 

about the learning materials 

1. Instructor will provide the learning materials 

‘Create table and PIVOT’ 

2. Read the Information sheet 

and complete the Self Checks 

& Check answer sheets on 

“Perform Tasks” 

2. Read Information sheet 4: Create table and 

PIVOT 

3. Answer Self-check 4: Create table and 

PIVOT 

4. Check your answer with Answer key 4: 

Create table and PIVOT 

3. Read the Job/Task Sheet and 

Specification Sheet and 

perform job/Task 

5. Job/Task Sheet and Specification Sheet  

Job Sheet-4: Create a Sample PivotTable in 

Excel 
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Information Sheet 4: Create table and PIVOT 

 
 

Learning Objective: 
 

After completion of this information sheet, the learners will be able to explain, 

define and interpret the following contents: 

 

4.1. Access Data 

4.2. Format data into a table. 

4.3. Design a pivot report according to requirements. 

4.4. Submit the report to the client 

 

4.1. Access data  

 

You might be under the impression that the data in your worksheet is already 

in a table simply because it's organized in rows and columns. However, the data 

in a tabular format is not a true "table" unless you've specifically made it such. 

 

Excel table is a special object that works as a whole and allows you to manage 

the table's contents independently from the rest of the worksheet data. 

 

The screenshot below contrasts a regular range and the table format 

 
 

The most obvious difference is that the table is styled. However, an Excel table 

is far more than a range of formatted data with headings. There are many 

powerful features inside 

 

• Excel tables are dynamic by nature, meaning they expand and contract 

automatically as you add or remove rows and columns. 

• Integrated sort and filter options; visual filtering with slicers. 

• Easy formatting with inbuilt table styles. 

• Column headings remain visible while scrolling. 
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• Quick totals allow you to sum and count data as well as find average, 

min or max value in a click. 

• Calculated columns allow you to compute an entire column by entering 

a formula in one cell. 

• Easy-to-read formulas due to a special syntax that uses table and 

column names rather than cell references. 

• Dynamic charts adjust automatically as you add or remove data in a 

table. 

 

A. How to create a table in Excel 

 

With the source data organized in rows and columns, carry out the below steps 

to covert a range of cells into a table 

1. Select any cell within your data set. 

2. On the Insert tab, in the Tables group, click the Table button or press 

the Ctrl + T shortcut. 

3. The Create Table dialog box appears with all the data selected for you 

automatically; you can adjust the range if needed. If you want the first 

row of data to become the table headers, make sure the My table has 

headers box is selected. 

4. Click OK. 

 

 

 



 

144 
 

As the result, Excel converts your range of data into a true table with the 

default style 

 
 

Many wonderful features are now just a click away and, in a moment, you will 

learn how to use them. But first, we'll look at how to make a table with a 

specific style. 

 

Tips and notes 

 

• Prepare and clean your data before creating a table: remove blank rows, 

give each column a unique meaningful name, and make sure each row 

contains information about one record. 

• When a table is inserted, Excel retains all formatting that you currently 

have. For best results, you may want to remove some of the existing 

formatting, e.g. background colors, so it does not conflict with a table 

style. 

• You are not limited to just one table per sheet, you can have as many as 

needed. For better readability, it stands to reason to insert at least one 

blank row and one blank column between a table and other data. 

 

4.2. Format data into a table. 

 

A. How to make a table with a selected style 

 

The previous example showed the fastest way to create a table in Excel, but it 

always uses the default style. To draw a table with the style of your choosing, 

perform these steps 

 

1. Select any cell in your data set. 

2. On the Home tab, in the Styles group, click Format as Table. 

3. In the gallery, click on the style you want to use. 

4. In the Create Table dialog box, adjust the range if necessary, check 

the My table has headers box, and click OK. 
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B. How to name a table in Excel 

 

Every time you make a table in Excel, it automatically gets a default name such 

asTable1, Table2, etc. When you deal with multiple tables, changing the default 

names to something more meaningful and descriptive can make your work a lot 

easier. 

To rename a table, just do the following 

 

1. Select any cell in the table. 

2. On the Table Design tab, in the Properties group, select the existing name 

in the Table Name box, and overwrite it with a new one. 

 

 

 

C. How to use tables in Excel 

 

Excel tables have many awesome features that simply calculating, manipulating 

and updating data in your worksheets. Most of these features are intuitive and 

straightforward. Below you will find a quick overview of the most important 

ones. 
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D. How to filter a table in Excel 

 

All tables get the auto-filter capabilities by default. To filter the table's data, this 

is what you need to do 

1. Click the drop-down arrow in the column header. 

2. Uncheck the boxes next to the data you want to filter out. Or uncheck 

the Select All box to deselect all the data, and then check the boxes next 

to the data you want to show. 

3. Optionally, you can use the Filter by Color and Text Filters options where 

appropriate. 

4. Click OK. 

 

 

 

If you don't need the auto-filter feature, you can remove the arrows by 

unchecking the Filter Button box on the Design tab, in the Table Style 

Options group. Or you can toggle the filter buttons on and off with the Ctrl + 

Shift + L shortcut. 

https://www.ablebits.com/office-addins-blog/excel-filter-add-use-remove/#filter-by-color
https://www.ablebits.com/office-addins-blog/excel-filter-add-use-remove/#filter-text-values
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Additionally, you can create a visual filter for your table by adding a slicer. For 

this, click Insert Slicer on the Table Design tab, in the Tools group. 

 

 
 

E. How to sort a table in Excel 

 

To sort a table by a specific column, just click the drop-down arrow in the 

heading cell, and pick the required sorting option 
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F. Excel table formulas 

For calculating the table data, Excel uses a special formula syntax 

called structured references. Compared to regular formulas, they have a number 

of advantages 

 

• Easy-to-create. Simply select the table's data when making a formula, 

and Excel will build a structured reference for you automatically. 

• Easy-to-read. Structured references refer to the table parts by name, 

which makes formulas easier to understand. 

• Auto-filled. To perform the same calculation in each row, enter a formula 

in any single cell, and it will be immediately copied throughout the 

column. 

• Changed automatically. When you modify a formula anywhere in a 

column, the other formulas in the same column will change accordingly. 

• Updated automatically. Every time the table is resized or the columns 

renamed, structured references update dynamically. 

 

The screenshot below shows an example of a structured reference that sums 

data in each row 
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Sum table columns 

 

Another great feature of an Excel table is the ability to summarize data without 

formulas. This option is called Total Row. 

 

To sum a table's data, this is what you need to do: 

1. Select any cell in the table. 

2. On the Design tab, in the Table Style Options group, put a tick mark in 

the Total Row box. 

 

 

The Total row is inserted at the bottom of the table and shows the total in the 

last column: 

 

 
 

To sum data in other columns, click in the Total cell, then click the drop-down 

arrow and choose the SUM function. To calculate data in a different way, e.g. 

count or average, select the corresponding function. 
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Whatever operation you choose, Excel would use the SUBTOTAL 

function that calculates data only in visible rows 

 

 
 

How to extend a table in Excel 

 

When you type anything in an adjacent cell, an Excel table expands 

automatically to include the new data. Combined with structured references, 

this creates a dynamic range for your formulas without any effort from your 

side. If you don't mean the new data to be part of the table, press Ctrl + Z. This 

will undo the table expansion but keep the data that you typed. 

 

You can also extend a table manually by dragging a little handle at the bottom-

right corner. 

 
 

You can also add and remove columns and rows by using the Resize 

Table command. Here's how 

1. Click anywhere in your table. 

2. On the Design tab, in the Properties group, click Resize Table. 

3. When the dialog box appears, select the range to be included in the table. 
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4. Click OK. 

 

 

Excel table styles 

 

Tables are very easily formatted due to a predefined gallery of styles. 

Additionally, you can create a custom style with your own formatting. 

 

How to change table style 

When you insert a table in Excel, the default style is automatically applied to it. 

To change a table style, do the following 

 

1. Select any cell in the table. 

2. On the Design tab, in the Table Styles group, click on the style you want 

to apply. To see all the styles, click the More button in the down-right 

corner. 
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Apply a table style and remove existing formatting 

 

When you format a table with any predefined style, Excel preserves the 

formatting you already have. To remove any existing formatting, right-click the 

style and choose Apply and Clear formatting 

 

 
 

Manage banded rows and columns 

 

To add or remove banded rows and columns as well as apply special formatting 

for the first or last column, simply tick or untick the corresponding checkbox 

on the Design tab in the Table Style Options group 

 
 

 

How to remove table formatting 
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If you'd like to have all the functionality of an Excel table but do not want any 

formatting such as banded rows, table borders and the like, you can remove 

formatting in this way 

1. Select any cell within your table. 

2. On the Design tab, in the Table Styles group, click the More button in the 

bottom-right corner, and then click Clear underneath the table style 

templates. Or pick the first style under Light, which is called None. 

 

 

 

How to remove table in Excel 

 

Removing a table is as easy as inserting it. To convert a table back to a range, 

just do the following: 

1. Right-click any cell in your table, and then click Table> Convert to 

Range. Or click the Convert to Range button on the Design tab, in 

the Tools group. 

2. In the dialog box that appear, click Yes 
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This will remove the table but retain all the data and formatting. To keep only 

the data, remove table formatting before converting your table to a range. 

 

4.3. 4.3 and 4.4 Create PIVOT Table and Format for Reporting  

 

What is a Pivot Table in Excel? 

 

An Excel Pivot Table is a tool to explore and summarize large amounts of data, 

analyze related totals and present summary reports designed to 

 

• Present large amounts of data in a user-friendly way. 

• Summarize data by categories and subcategories. 

• Filter, group, sort and conditionally format different subsets of data so 

that you can focus on the most relevant information. 

• Rotate rows to columns or columns to rows (which is called "pivoting") 

to view different summaries of the source data. 

• Subtotal and aggregate numeric data in the spreadsheet. 

• Expand or collapse the levels of data and drill down to see the details 

behind any total. 

• Present concise and attractive online of your data or printed reports. 

For example, you may have hundreds of entries in your worksheet with sales 

figures of local resellers 

 
 

 

One possible way to sum this long list of numbers by one or several conditions 

is to use formulas as demonstrated in SUMIF and SUMIFS tutorials. However, 

if you want to compare several facts about each figure, using a Pivot Table is a 

far more efficient way. In just a few mouse clicks, you can get a resilient and 
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easily customizable summary table that totals the numbers by any field you 

want. 

 

 
 

 

 

The screenshots above demonstrate just a few of many possible layouts. And 

the steps below show how you can quickly create your own Pivot Table in all 

versions of Excel. 

 

How to make a Pivot Table in Excel 

 

Many people think that creating a Pivot Table is burdensome and time-

consuming. But this is not true! Microsoft has been refining the technology for 

many years, and in the modern versions of Excel, the summary reports are user-

friendly are incredibly fast. In fact, you can build your own summary table in 

just a couple of minutes. And here's how: 

 

1. Organize your source data 
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Before creating a summary report, organize your data into rows and columns, 

and then convert your data range in to an Excel Table. To do this, select all of 

the data, go to the Insert tab and click Table. 

 

Using an Excel Table for the source data gives you a very nice benefit - your 

data range becomes "dynamic". In this context, a dynamic range means that 

your table will automatically expand and shrink as you add or remove entries, 

so won't have to worry that your Pivot Table is missing the latest data. 

 

Useful tips 

• Add unique, meaningful headings to your columns, they will turn into the 

field names later. 

• Make sure your source table contains no blank rows or columns, and no 

subtotals. 

• To make it easier to maintain your table, you can name your source table 

by switching to the Design tab and typing the name in the Table 

Name box the upper right corner of your worksheet. 

 

 

Create a Pivot Table 

 

Select any cell in the source data table, and then go to the Insert tab 

> Tables group > PivotTable. 

 

 
 

This will open the Create PivotTable window. Make sure the correct table or 

range of cells is highlighted in the Table/Range field. Then choose the target 

location for your Excel Pivot Table: 

• Selecting New Worksheet will place a table in a new worksheet starting 

at cell A1. 

• Selecting Existing Worksheet will place your table at the specified 

location in an existing worksheet. In the Location box, click the Collapse 

Dialog button  to choose the first cell where you want to position your 

table. 
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Clicking OK creates a blank Pivot Table in the target location, which will look 

similar to this 
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Arrange the layout of your Pivot Table report 

 

The area where you work with the fields of your summary report is 

called PivotTable Field List. It is located in the right-hand part of the 

worksheet and divided into the header and body sections 

 

• The Field Section contains the names of the fields that you can add to 

your table. The filed names correspond to the column names of your 

source table. 

• The Layout Section contains the Report 

Filter area, Column Labels, Row Labels area, and the Values area. Here 

you can arrange and re-arrange the fields of your table. 
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The changes that you make in the PivotTable Field List are immediately 

reflected to your table. 

 

How to add a field to Pivot Table 

 

To add a field to the Layout section, select the check box next to the field name 

in the Field section. 

 

 
 

By default, Microsoft Excel adds the fields to the Layout section in the 

following way 

 

• Non-numeric fields are added to the Row Labels area; 

• Numeric fields are added to the Values area; 

• Online Analytical Processing (OLAP) date and time hierarchies are added 

to the Column Labels area. 

 

How to remove a field from a Pivot Table 

 

To delete a certain field, you can either 

 

• Uncheck the box nest to the field's name in the Field section of the 

PivotTable pane. 

• Right-click on the field in your Pivot Table, and then click "Remove 

Field_Name". 
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How to arrange Pivot Table fields 

 

You can arrange the fields in the Layout section in three ways 

 

1. Drag and drop fields between the 4 areas of the Layout section using the 

mouse. Alternatively, click and hold the field name in the Field section, 

and then drag it to an area in the Layout section - this will remove the field 

from the current area in the Layout section and place it in the new area. 
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2. Right-click the field name in the Field section, and then select the area 

where you want to add it 

 

3. Click on the filed in the Layout section to select it. This will also display 

the options available for that particular field. 
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4. Choose summary function for Values (optional) 

 

By default, Microsoft Excel applies the Sum function to numeric value fields 

placed in the Values area. Conversely, for non-numeric data (such as text, dates, 

or Boolean values), the Count function is automatically applied. 

However, you are free to choose a different summary function according to your 

preference. For this, right-click on the value field you wish to modify, 

select Summarize Values By, and then choose the desired function from the 

options provided. 

Below, you'll find an example of a Pivot Table utilizing the Averagefunction 
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The functions' names are mostly self-explanatory 

• Sum - calculates the sum of the values. 

• Count - counts the number of non-empty values (works as the COUNTA 

function). 

• Average - calculates the average of the values. 

• Max - finds the largest value. 

• Min - finds the smallest value. 

• Product - calculates the product of the values. 

 

To get more specific functions, click Summarize Values By > More Options…. 

 

Show different calculations in value fields (optional) 

 

Excel Pivot Tables provide one more useful feature that enables you to present 

values in different ways, for example show totals as percentage or rank 

values from smallest to largest and vice versa.  

 

This feature is called Show Values As and it's accessible by right-clicking the 

field in the table in Excel 2013 and higher. In Excel 2010 and lower, you can 

also find this option on the Options tab, in the Calculations group. 
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Working with PivotTable Field List 

 

The Pivot Table pane, which is formally called PivotTable Field List, is the 

main tool that you use to arrange your summary table exactly the way you want. 

To make your work with the fields more comfortable, you may want to 

customize the pane to your liking. 

 

Changing the Field List view 

If you want to change how the sections are displayed in the Field List, click 

the Tools button, and choose your preferred layout. 
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You can also resize the pane horizontally by dragging the bar (splitter) that 

separates the pane from the worksheet. 

 

Closing and opening the PivotTable pane 

 

Closing the PivotTableField List is as easy as clicking the Close button (X) in 

the top right corner of the pane.Making it to show up again is not so obvious :) 

To display the Field List again, right-click anywhere in the table, and then 

select Show Field List from the context menu. 
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You can also click the Field List button on the Ribbon, which resides on 

the Analyze / Options tab, in the Show group. 

 
 

Using Recommended PivotTables 

 

As you have just seen, creating a Pivot Table in Excel is easy. However, the 

modern versions of Excel take even a step further and make it possible to 

automatically make a report most suited for your source data. All you have to 

do is 4 mouse clicks 

 

1. Click any cell in your source range of cells or table. 

2. On the Insert tab, click Recommended PivotTables. Microsoft Excel 

will immediately display a few layouts, based on your data. 

3. In the Recommended PivotTables dialog box, click a layout to see its 

preview. 

4. If you are happy with the preview, click the OK button, and get a Pivot 

Table added to a new worksheet. 
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As you see in the screenshot above, Excel was able to suggest just a couple of 

basic layouts for my source data, which are far inferior to the Pivot Tables we 

created manually a moment ago. Of course, this is only my opinion and I am 

biased, you know : ) 

Overall, using the Recommended PivotTable is a quick way to get started, 

especially when you have a lot of data and are not sure where to start. 

 

How to use Pivot Table in Excel 

 

Now that you know the basics, you can navigate to 

the Analyze and Design tabs of the PivotTable Tools in Excel 2013 and 

higher, (Options and Design tabs in Excel 2010 and 2007) to explore the 

groups and options provided there. These tabs become available as soon as you 

click anywhere within your table. 

 

 
 

You can also access options and features that are available for a specific element 

by right-clicking on it. 
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Self-Check Sheet 4: Create table and PIVOT 

 

01. Which of the following statements about Excel tables is TRUE? 
 

A. They can only be applied to numerical data. 

B. They convert your data into a chart by default. 

C. They dynamically adjust in size as you add or remove data.  

D. They require a separate add-on to be installed. 

 

02. When filtering data in an Excel table, what happens to the hidden rows? 

A. They are permanently deleted from the table. 

B. Their formulas are recalculated to exclude them. 

C. They are visually hidden but still included in calculations.  

D. They are moved to a separate sheet in the workbook. 

 

03. Structured references in Excel tables offer which advantage over regular cell 

references? 

A. They allow you to use complex mathematical symbols. 

B. They are automatically updated when the table structure changes.  

C. They require less typing for simple formulas. 

D. They can only be used with specific functions. 

 

04. What is the keyboard shortcut for converting a table back to a regular data range in 

Excel? 

A. Ctrl + P 

B. Ctrl + Shift + T 

C. Alt + F8 

D. There is no shortcut; it must be done through the menu. 

E. Ctrl + T  
 

05. Which of these is NOT a way to format an Excel table? 

A. Applying a pre-defined table style 

B. Manually changing font size and color 

C. Using conditional formatting based on cell values 

D. Inserting a slicer to filter data visually  
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Answer Key 4: Create table and PIVOT 

 

01. Which of the following statements about Excel tables is TRUE? 

 

A. They can only be applied to numerical data. 

B. They convert your data into a chart by default. 

C. They dynamically adjust in size as you add or remove data. ** (Answer) ** 

D. They require a separate add-on to be installed. 

 

02. When filtering data in an Excel table, what happens to the hidden rows? 

A. They are permanently deleted from the table. 

B. Their formulas are recalculated to exclude them. 

C. They are visually hidden but still included in calculations. ** (Answer) ** 

D. They are moved to a separate sheet in the workbook. 

 

03. Structured references in Excel tables offer which advantage over regular cell 

references? 

A. They allow you to use complex mathematical symbols. 

B. They are automatically updated when the table structure changes. ** (Answer) ** 

C. They require less typing for simple formulas. 

D. They can only be used with specific functions. 

 

04. What is the keyboard shortcut for converting a table back to a regular data range in 

Excel? 

A. Ctrl + P 

B. Ctrl + Shift + T 

C. Alt + F8 

D. There is no shortcut; it must be done through the menu. 

E. Ctrl + T ** (Answer) ** 

 

05. Which of these is NOT a way to format an Excel table? 

A. Applying a pre-defined table style 

B. Manually changing font size and color 

C. Using conditional formatting based on cell values 

D. Inserting a slicer to filter data visually ** (Answer) ** 
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Job Sheet-4: Create a Sample PivotTable in Excel 

 

Working Procedure:  

 

1. Sample Data: 

• Use the provided sample data table below. (Replace this with your actual data 

table). 

Sample Data Table: 

Order ID Product Name Category Price Order Date Country 

1001 Shirt Clothing $20.00 2024-04-01 USA 

1002 Hat Accessories $15.00 2024-04-05 Canada 

1003 Jeans Clothing $35.00 2024-04-10 USA 

1004 Phone Case Accessories $10.00 2024-04-12 UK 

1005 Watch Accessories $50.00 2024-04-15 USA 

 

2. Create a PivotTable: 

• Select the entire data table, including headers. 

• Go to the Insert tab on the Excel ribbon. 

• Click the PivotTable button. 

• In the Create PivotTable dialog box, ensure the correct table/range is selected 

and choose where you want to place the PivotTable (New Worksheet or 

Existing Worksheet). Click OK. 

3. PivotTable Fields: 

The PivotTable Fields pane will appear on the right side of your screen. This pane lists 

the fields available in your data table. 

• Drag and drop fields to the following areas to customize your PivotTable: 

o Rows: This area displays categories or groupings for your data 

(e.g., Product Name, Category). 

o Columns: This area displays another way to categorize your data 

(e.g., Country). 
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o Values: This area displays summarized data based on calculations 

(e.g., Sum of Price). 

4. Sample PivotTable Analysis: 

• Scenario 1: Analyze total sales per country. 

o Drag Country field to the Rows area. 

o Drag Price field to the Values area. 

o Choose the Sum function to calculate total sales. 

o This PivotTable will show the total sales amount for each country. 

• Scenario 2: Analyze average price per product category. 

o Drag Category field to the Rows area. 

o Drag Price field to the Values area. 

o Choose the Average function to calculate the average price per category. 

o This PivotTable will show the average price for each product category. 

5. Experimentation: 

• Try different combinations of fields in rows, columns, and values to explore 

your data from various perspectives. 

• Use filters within the PivotTable to focus on specific data sets (e.g., filter by a 

specific date range). 

Deliverable: 

• A completed Excel workbook with a sample data table and a PivotTable 

analyzing the data in two different scenarios. 
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Specification Sheet-4: Create a Sample PivotTable in Excel 
 

 

Necessary Tools  
 

Sl. No Name of Tools Specification Unit Quantity 

4      

 

Necessary Equipment 
 

Sl. No Name of Equipment Specification Unit Quantity 

7.  Computer  As Need No. 01 

8.  Spreadsheet Software  As Need No. 01 
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Learning Outcome 5: Using Tools 

 

Assessment Criteria 

 

1. Able to select tools according to requirements 

2. Able to use tools according to requirements 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

Contents 

1. Tools 

2. Data Validation 

3. Remove Duplicate Data 

4. Data Sorting and Filtering 

5. Text to Columns 

6. Advanced Filtering 

7. Data Consolidation 

8. Hyperlink 

Activities/job/Task 
1. Create a Worksheet include data validation, Duplicate 

Removing, Data sorting and Filtering 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning 

4. Portfolio   

 

 

  



 

174 
 

Learning Experience 5: Use Tools 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

1. Trainee will ask the instructor about 

about the learning materials 

1. Instructor will provide the learning materials 

‘Use Tools’ 

2. Read the Information sheet 

and complete the Self Checks 

& Check answer sheets on 

“Use Tools” 

2. Read Information sheet 5: Use Tools 

3. Answer Self-check 5: Use Tools 

4. Check your answer with Answer key 5: Use 

Tools 

3. Read the Job/Task Sheet and 

Specification Sheet and 

perform job/Task 

5. Job/Task Sheet and Specification Sheet  

Job Sheet-5: Create Checklist - Task 

Revision and Update Process 
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Information Sheet 5: Use Tools 

 

 

Learning Objective: 

 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 

 

5.1.Select tools according to requirements 

5.2. Use tools according to requirements 

 

 

5.1 and 5.2 Select and Use Excel Tools  

 

Data Validation 

 

Excel Data Validation is a feature that restricts (validates) user input to a 

worksheet. Technically, you create a validation rule that controls what kind of 

data can be entered into a certain cell. 

 

Here are just a few examples of what Excel's data validation can do: 

• Allow only numeric or text values in a cell. 

• Allow only numbers within a specified range. 

• Allow data entries of a specific length. 

• Restrict dates and times outside a given range. 

• Restrict entries to a selection from a drop-down list. 

• Validate an entry based on another cell. 

• Show an input message when the user selects a cell. 

• Show a warning message when incorrect data has been entered. 

• Find incorrect entries in validated cells. 

 

For instance, you can set up a rule that limits data entry to 4-digit numbers 

between 1000 and 9999. If the user types something different, Excel will show 

an error alert explaining what they have done wrong 
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How to do data validation in Excel 

 

To add data validation in Excel, perform the following steps. 

 

1. Open the Data Validation dialog box 

 

Select one or more cells to validate, go to the Data tab > Data Tools group, and 

click the Data Validation button. 

 

You can also open the Data Validation dialog box by pressing Alt > D > L, with 

each key pressed separately. 

 

 

 
 

 

 



 

177 
 

 

2. Create an Excel validation rule 

 

On the Settings tab, define the validation criteria according to your needs. In 

the criteria, you can supply any of the following 

 

• Values - type numbers in the criteria boxes like shown in the screenshot 

below. 

• Cell references - make a rule based on a value or formula in another cell. 

• Formulas - allow to express more complex conditions  

 

As an example, let's make a rule that restricts users to entering a whole number 

between 1000 and 9999 

 
 

With the validation rule configured, either click OK to close the Data 

Validation window or switch to another tab to add an input message or/and 

error alert. 

 

3. Add an input message (optional) 

 

If you want to display a message that explains to the user what data is allowed 

in a given cell, open the Input Message tab and do the following 

 

• Make sure the Show input message when cell is selected box is 

checked. 

• Enter the title and text of your message into the corresponding fields. 
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• Click OK to close the dialog window. 

 

 
 

As soon as the user selects the validated cell, the following message will show 

up 

 
 

4. Display an error alert (optional) 

In addition to the input message, you can show one of the following error alerts 

when invalid data is entered in a cell. 
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Alert type Description 

Stop (default) 
 

The strictest alert type that prevents users from entering invalid 

data. 

You click Retry to type a different value or Cancel to remove 

the entry. 

Warning 

 
Warns users that the data is invalid, but does not prevent 

entering it. 

You click Yes to input the invalid entry, No to edit it, 

or Cancel to remove the entry. 

Information 
 

The most permissive alert type that only informs users about 

an invalid data entry. 

You click OK to enter the invalid value or Cancel to remove it 

from the cell. 

 

To configure a custom error message, go to the Error Alert tab and define the 

following parameters 
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• Check the Show error alert after invalid data is entered box (usually 

selected by default). 

• In the Style box, select the desired alert type. 

• Enter the title and text of the error message into the corresponding boxes. 

• Click OK. 

 
 

And now, if the user enters invalid data, Excel will display a special alert 

explaining the error (like shown in the beginning of this tutorial). 

 

Note. If you do not type your own message, the default Stop alert with the 

following text will show up: This value does not match the data validation 

restrictions defined for this cell. 

 

Excel data validation examples 

 

When adding a data validation rule in Excel, you can choose one of the 

predefined settings or specify custom criteria based on your own validation 

formula. Below we will discuss each of the built-in options, and next week we 

will have a closer look at Excel data validation with custom formulas in a 

separate tutorial. 

 

As you already know, the validation criteria are defined on the Settings tab of 

the Data Validation dialog box (Data tab > Data Validation). 
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Whole numbers and decimals 

 

To restrict data entry to a whole number or decimal, select the corresponding 

item in the Allow box. And then, choose one of the following criteria in 

the Data box 

 

• Equal to or not equal to the specified number 

• Greater than or less than the specified number 

• Between the two numbers or not between to exclude that range of 

numbers 

For example, this is how you create an Excel validation rule that allows any 

whole number greater than 0: 

 

 
 

Date and time validation in Excel 

 

To validate dates, select Date in the Allow box, and then pick an appropriate 

criteria in the Data box. There are quite a lot of predefined options to choose 

from: allow only dates between two dates, equal to, greater than or less than a 

specific date, and more. 

Similarly, to validate times, select Time in the Allow box, and then define the 

required criteria. 

For example, to allow only dates between Start date in B1 and End date in B2, 

apply this Excel date validation rule 
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Text length 

 

To allow data entry of a specific length, select Text length in the Allow box, 

and choose the validation criteria in accordance with your business logic. 

For example, to limit the input to 10 characters, create this rule 

 

 
 

Excel data validation list (drop-down) 
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To add a drop-down list of items to a cell or a group of cells, select the target 

cells and do the following 

1. Open the Data Validation dialog box (Data tab > Data Validation). 

2. On the Settings tab, select List in the Allow box. 

3. In the Source box, type the items of your Excel validation list, separated 

by commas. For example, to limit the user input to three choices, 

type Yes, No, N/A. 

4. Make sure the In-cell dropdown box is selected in order for the drop-

down arrow to appear next to the cell. 

5. Click OK. 

 

 

 

The resulting Excel data validation list will look similar to this 

 

 
 

 

Note. Please be careful with the Ignore blank option, which is selected by 

default. If you are creating a drop-down list based on a named range that has 

at least one blank cell, selecting this check box allows entering any value in 
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the validated cell. In many situations, it is also true for validation formulas: if 

a cell referenced in the formula is blank, any value will be allowed in the 

validated cell. 

 

How to edit data validation in Excel 

 

To change an Excel validation rule, perform these steps 

1. Select any of the validated cells. 

2. Open the Data Validation dialog box (Data tab > Data Validation). 

3. Make the required changes. 

4. Select the Apply these changes to all other cells with the same 

settings check box to copy the changes you've made to all other cells 

with the original validation criteria. 

5. Click OK to save the changes. 

For instance, you can edit your Excel data validation list by adding or 

removing items from the Source box, and have these changes applied to all 

other cells containing the same drop-down list 

 

 
 

How to copy Excel data validation rule to other cells 

 

If you've configured data validation for one cell and wish to validate other cells 

with the same criteria, you don't have to re-create the rule from scratch. 

 

To copy the validation rule in Excel, perform these 4 quick steps 



 

185 
 

1. Select the cell to which the validation rule applies and press Ctrl + C to 

copy it. 

2. Select other cells you want to validate. To select non-adjacent cells, press 

and hold the Ctrl key while selecting the cells. 

3. Right-click the selection, click Paste Special, and then select 

the Validation option. 

Alternatively, press the Paste Special > Validation shortcut: Ctrl + Alt + V, 

then N. 

4. Click OK. 

 

 

 

How to find cells with data validation in Excel 

 

To quickly locate all validated cells in the current worksheet, go to 

the Home tab > Editing group, and click Find & Select > Data Validation 

 



 

186 
 

 
 

 

 

This will select all cells that have any data validation rules applied to them 

 
 

How to remove data validation in Excel 

 

Overall, there are two ways to remove validation in Excel: the standard 

approach designed by Microsoft and the mouse-free technique devised by 

Excel geeks who would never take their hands off the keyboard unless 

absolutely necessary (e.g. to take a cup of coffee :) 

 

Method 1: Regular way to remove data validation 

 

Normally, to remove data validation in Excel worksheets, you proceed with 

these steps: 

1. Select the cell(s) with data validation. 

2. On the Data tab, click the Data Validation button. 
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3. On the Settings tab, click the Clear All button, and then click OK. 

 
 

Method 2: Paste Special to delete data validation rules 

 

De jure, Excel Paste Special is designed for pasting specific elements of 

copied cells. De facto, it can do many more useful things. Among others, it 

can quickly remove data validation rules in a worksheet. Here's how 

 

1. Select an empty cell without data validation, and press Ctrl + C to copy 

it. 

2. Select the cells(s) from which you want to remove data validation. 

3. Press Ctrl + Alt + V, then N, which is the shortcut for Paste 

Special > Data Validation. 

4. Press Enter. Done! 

 

Remove Duplicate Data 

 

In all versions of Excel 365 - 2007, there is a built-in tool for removing 

duplicates called, not surprisingly, Remove Duplicates. 

 

This tool allows you to find and remove absolute duplicates (cells or entire 

rows) as well as partially matching records (rows that have identical values 

in a specified column or columns). To perform this, follow the below steps. 
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1. To begin with, select the range in which you want to ddelete dupes. To 

select the entire table, press Ctrl + A. 

2. Go to the Data tab > Data Tools group, and click the Remove 

Duplicates button. 

 

 

 

3. The Remove Duplicates dialog box will open, you select the columns to 

check for duplicates, and click OK. 

o To delete duplicate rows that have completely equal values in all 

columns, leave the check marks next to all columns, like in the 

screenshot below. 

o To remove partial duplicates based on one or more key 

columns, select only those columns. If your table has many 

columns, the fastest way is to click the Unselect All button, and 

then select the columns you want to check for dupes. 

o If your table does not have headers, clear the My data has 

headers box in the upper-right corner of the dialog window, 

which is usually selected by default. 
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Done! All duplicate rows in the selected range are deleted, and a message is 

displayed indicating how many duplicate entries have been removed and how 

many unique values remain. 

 
 

 

Data Sorting and Filtering 

 

Enabling Sort & Filter for a Data Set 

 

The first step to sorting and filtering data is enabling the capabilities of a 

dataset. Each of the steps needed to enable sort and filter in Excel is shown 

below 

 

Step 1. Select the row of headers. 

Step 2. While on the "Home" tab, click the sort and filter button in the editing 

section of the ribbon. 

Step 3. Click on the filter option. 

 



 

190 
 

Enabling Sort & Filter 

 

 
 

The sort and filter options are located under the home tab in the Excel ribbon. 

Each column header will have an arrow in the cell that can be clicked to display 

a menu of sort and filter tools. These added arrows are highlighted in the 

illustration below. 

 

 
 

Sorting A to Z in Excel 

Sorting from A to Z (or sorting from Z to A) can be accomplished in two steps. 

The 

Step 1. Select the down arrow on the column. 
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Step 2. Select one of the first two sorting options. 

 

 
 

Excluding Data in Excel 

 

Data can be excluded by clicking on the down arrow located on the header and 

making changes to the checkboxes in the menu. Unchecking a box will exclude 

it from the data set. 

You may have outliers in the data that you would like to exclude temporarily. 

If you require only a few pieces of data, the select all check box can be 

unchecked giving you the opportunity to select what data is displayed by only 

checking the corresponding boxes. 
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Date Exclusion Option in Excel 

 

 
 

 

This above illustration shows the filtering option where data can be excluded 

by unchecking boxes. 

 

Using the Custom Auto Filter in Excel 

 

Text filters can come in handy especially if you have data with a lot of 

attributes to analyze. With this tool you can filter by equals, does not equal, 

greater than, less than, begins with ends with, and contains. 

 

For a text filter example, let us look at the equals filter. The equals filter will 

display the exact data that is specified. In the illustration below I walk through 

each step to use this tool to filter by 2. 

1. Click the down arrow on the header 

2. Select text filters and equals 

3. Enter 2 into the field after equals 
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Note that you are not limited to just one filter. An additional filter like one that 

will show all numbers greater than 4 can be added as well. 

 

 
 

Text to Columns 

 

To separate the contents of one Excel cell into separate columns, you can use 

the 'Convert Text to Columns Wizard'. For example, when you want to 

separate a list of full names into last and first names. 

1. Select the range with full names. 

 

 

2. On the Data tab, in the Data Tools group, click Text to Columns. 
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The following dialog box appears. 

3. Choose Delimited and click Next. 

 

 

 

4. Clear all the check boxes under Delimiters except for the Comma and Space 

check box. 

5. Click Finish. 
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Result 
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Advanced Filtering 

 

Step 1: Prepare Your Data. 

 

Make sure your data is well-organized with column headers, and you know the 

specific criteria you want to use for filtering. 

 

Step 2: Select the Data Range. 

 

Click anywhere within the dataset you want to filter. Excel will automatically 

detect the boundaries of your data. Or, you can manually select the data range 

by clicking and dragging over the cells. 

 

Step 3: Access the Advanced Filter Dialog Box. 

 

Go to the "Data" tab in the Excel ribbon. In the "Sort & Filter" group, click on 

"Advanced." 

 

 
 

Step 4: Define the Criteria Range 

 

In the Excel Advanced Filter dialog box that appears: 

• Choose whether you want to filter the data in place (replace the original 

data with the filtered data) or copy it to another location. If you choose to 
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filter in place, make sure you have enough empty rows below your data 

to accommodate the filtered results. 

• Specify the "List range," which is the range of cells containing your data. 

• Specify the "Criteria range," which is a range of cells where you will 

define your filtering criteria. 

 

Step 5: Define Filtering Criteria 

 

In the criteria range you specified: 

• Create column headers that match the headers in your data. 

• Under each column header, specify the filtering criteria. You can use 

comparison operators like "=," "<>," "<, ",”>," "<=," ">”, “=" or logical 

operators like "AND" and "OR" to define complex criteria. 

• Leave cells blank for columns where you don't want to apply any criteria. 

 

 
 

Step 6: View the Filtered Data 

 

• Excel will apply the advanced filter based on your criteria. 
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• If you choose to filter in place, you'll see the filtered results in your 

original data range. If you choose to copy the data, it will appear in the 

specified location. 

 

 
 

Step 7: Clear the Filter (Optional) 

• To remove the filter and restore your original data, go back to the "Data" 

tab, click on "Clear" in the "Sort & Filter" group, and select "Clear 

Filters." 

 

Data Consolidation 

 

Rows consolidation in Excel can be helpful when you have multiple rows with 

the same entries. 

Let’s say you have a record of various orders placed on an e-commerce store 

containing columns for order ID, product SKU, and quantity. 
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Here, you can use data consolidation to get the total quantity for each product 

by adding up quantities with similar SKUs. 

 

You can follow these steps to consolidate data from rows: 

1. Open the Excel sheet and select the target cell where you want to place 

the consolidated rows. 

 

2. In the upper tab, select Data, and click on Consolidate in the ‘Data Tools’ 

section. 

 

 

3. The ‘Consolidate’ window will appear on the screen. Select the appropriate 

function, click on the little upside arrow in the reference field, and select the 

reference ranges. 
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4. After selecting the range, click on Add button to add it as a reference. Check 

the appropriate option in the ‘Use labels in’ section (It is ‘Left column’ in this 

example to add up product quantities with the same SKU), and click on OK to 

proceed. 

 

 

 

5. Verify the results for a couple of rows manually to ensure that the rows have 

been accurately consolidated. 
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Hyperlink 

 

An Excel hyperlink is a reference to a specific location, document or web-page 

that the user can jump to by clicking the link. 

 

Microsoft Excel enables you to create hyperlinks for many different purposes 

including: 

• Going to a certain location within the current workbook 

• Opening another document or getting to a specific place in that document, 

e.g. a sheet in an Excel file or bookmark in a Word document. 

• Navigating to a web-page on the Internet or Intranet 

• Creating a new Excel file 

• Sending an email to a specified address 

 

Hyperlinks in Excel are easily recognizable - generally this is text highlighted 

in underlined blue like shown in the screenshot below. 
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Absolute and relative hyperlinks in Excel 

 

Microsoft Excel supports two types of links: absolute and relative, depending 

on whether you specify a full or partial address. 

 

An absolute hyperlink contains a full address, including the protocol and 

domain name for URLs, and the entire path and file name for documents. For 

example: 

Absolute URL: https://www.ablebits.com/excel-lookup-tables/index.php 

Absolute link to an Excel file: C:\Excel files\Source Data\Book1.xlsx 

A relative hyperlink contains a partial address. For example: 

Relative URL: excel-lookup-tables/index.php 

Relative link to an Excel file: Source data\Book3.xlsx 

 

On the web, it's a common practice to use relative URLs. In your Excel 

hyperlinks, you should always supply full URLs for web-pages. Though, 

Microsoft Excel can understand URLs without a protocol. For example, if you 

type "www.ablebits.com" in a cell, Excel will automatically add the default 

"http" protocol and convert it into a hyperlink you can follow. 

When creating links to Excel files or other documents stored on your computer, 

you can use either absolute or relative addresses. In a relative hyperlink, a 

missing part of the file path is relative to the location of the active workbook. 

The main advantage of this approach is that you don't have to edit the link 

address when the files are moved to another location. For example, if your 

active workbook and target workbook reside on drive C, and then you move 

them to drive D, relative hyperlinks will continue working as long as the relative 

path to the target file remains unchanged. In case of an absolute hyperlink, the 

path should be updated every time the file is moved to another place. 

 

How to create a hyperlink in Excel 

 

The most common way to put a hyperlink directly into a cell is by using 

the Insert Hyperlink dialog, which can be accessed in 3 different ways. Just 

select the cell where you want to insert a link and do one of the following 

• On the Insert tab, in the Links group, click 

the Hyperlink or Link button, depending on your Excel version. 
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• Right click the cell, and select Hyperlink… (Link in recent versions) 

from the context menu. 

 
 

• Press the Ctrl + K shortcut. 
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Self-Check Sheet 5: Use Tools 

 

1. Which of the following is NOT a type of data validation allowed in Excel? 

 

a) Restricting data to a specific range of numbers 

b) Allowing only text entries 

c) Limiting the length of the data entered 

d) Matching data to a specific format (e.g., Social Security Number) 
 

 

2. How can you remove duplicate rows in an Excel dataset? 
 

a) Manually select and delete duplicate rows. 

b) Use the "Sort" function to group duplicates. 

c) Use the "Remove Duplicates" tool. 

d) Use a custom formula to identify duplicates. 
 

 

3. When sorting data in Excel from A to Z, which option do you select from the dropdown 

menu in the column header? 
 

a) "Filter" 

b) "Sort Ascending" 

c) "Sort Descending" 

d) "Custom Sort" 
 

 

4. How can you filter data in Excel to show only entries containing the word "apple"? 
 

a) Use the "Sort" function. 

b) Use the "Find" function. 

c) Use a custom formula. 

d) Use the text filter with the "contains" option. 
 

 

5. What is the purpose of using the "Text to Columns" feature in Excel? 
 

a) To convert numbers to text format. 

b) To separate text within a single cell into multiple columns. 

c) To combine data from multiple cells into one cell. 

d) To add borders around cells. 
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Answer Key 5: Use Tools 

1. Which of the following is NOT a type of data validation allowed in Excel? 

 

a) Restricting data to a specific range of numbers 

b) Allowing only text entries 

c) Limiting the length of the data entered 

d) Matching data to a specific format (e.g., Social Security Number) 
 

Answer: d) Matching data to a specific format (e.g., Social Security Number)  
 

2. How can you remove duplicate rows in an Excel dataset? 
 

a) Manually select and delete duplicate rows. 

b) Use the "Sort" function to group duplicates. 

c) Use the "Remove Duplicates" tool. 

d) Use a custom formula to identify duplicates. 
 

Answer: c) Use the "Remove Duplicates" tool. 
 

3. When sorting data in Excel from A to Z, which option do you select from the dropdown 

menu in the column header? 
 

a) "Filter" 

b) "Sort Ascending" 

c) "Sort Descending" 

d) "Custom Sort" 
 

Answer: b) "Sort Ascending" 

 

4. How can you filter data in Excel to show only entries containing the word "apple"? 
 

a) Use the "Sort" function. 

b) Use the "Find" function. 

c) Use a custom formula. 

d) Use the text filter with the "contains" option. 
 

Answer: d) Use the text filter with the "contains" option. 
 

5. What is the purpose of using the "Text to Columns" feature in Excel? 
 

a) To convert numbers to text format. 

b) To separate text within a single cell into multiple columns. 

c) To combine data from multiple cells into one cell. 

d) To add borders around cells. 
 

Answer: b) To separate text within a single cell into multiple columns. 
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Job Sheet-5: Create a Worksheet include data validation, Duplicate 

Removing, Data sorting and Filtering  

 

Working Procedure:  

 

1. Sample Data: 

• Use the provided sample data table below.  

Sample Data Table: 

Product 

ID 

Product Name (may 

contain typos) 

Unit Price (may contain 

inconsistencies) 

Category 

101 Shirt (duplicate) $19.99 Clothing 

102 Hat $14.50 Accessories 

103 Jeans $34.95 Clothing 

(misspelled) 

101 Shirt (duplicate) $19.75 Clothing 

104 Phone Case $9.99 Accessories 

 

2. Data Validation: 

• Scenario 1: Ensure product IDs are unique. 

o Select the column containing product IDs. 

o Go to the Data tab on the Excel ribbon. 

o Click on Data Validation. 

o In the Settings tab, choose Allow as Unique. 

o Click OK. 

o Now, trying to enter a duplicate ID will display an error message. 

• Scenario 2: Limit unit price entries to a specific range (e.g., $5 to $50). 

o Select the column containing unit prices. 

o Follow steps for Data Validation (Data tab -> Data Validation). 

o In the Settings tab, choose Allow as Decimal and set minimum and 

maximum values. 

o Click OK. 
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3. Remove Duplicate Data: 

• Select the entire data table. 

• Go to the Data tab on the Excel ribbon. 

• Click on Remove Duplicates. 

• In the Remove Duplicates dialog box, choose the columns where duplicates 

should be removed (e.g., Product ID). 

• Click OK. 

• This will remove duplicate rows based on the selected criteria. 

4. Data Sorting and Filtering: 

• Sorting: Sort the data table by product name (ascending) and then by unit price 

(descending). 

o Select the entire data table. 

o Go to the Data tab on the Excel ribbon. 

o Click on Sort. 

o Choose Sort by the desired columns (Product Name, Unit Price) and 

their sort order (ascending/descending). 

o Click OK. 

• Filtering: Filter the data table to show only products in the "Clothing" category. 

o Select the entire data table. 

o Click the down arrow in the header row of the "Category" column. 

o Choose the checkbox next to "Clothing" and uncheck others. 

o Only rows with "Clothing" in the category will be displayed. 
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Specification Sheet-5: Create a Worksheet include data validation, 

Duplicate Removing, Data sorting and Filtering 
 

 

Necessary Tools  

 

Sl. No Name of Tools Specification Unit Quantity 

5      

 

Necessary Equipment 

 

Sl. No Name of Equipment Specification Unit Quantity 

9.  Computer  As Need No. 01 

10.  Spreadsheet Software  As Need No. 01 
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Learning Outcome 6: Develop Real Life Project  

 

Assessment Criteria 

 

1. Able to determine Project type  

2. Able to Design Structure of project  

3. Able to develop Project as per design 

Conditions and 

Resources 

 

1. Real or simulated workplace 

2. CBLM 

3. Handouts 

4. Laptop 

5. Multimedia Projector 

6. Paper, Pen, Pencil, Eraser 

7. Internet facilities 

8. White board and marker 

9. Audio Video Device 

Contents 

1. Project Types 

o Accounting System 

o Inventory System 

o Payroll System 

2.  Determining Project Type 

3. Designing Project Structure 

Activities/job/Task 
1. Create a Basic Accounting System (Grocery Shop) using 

Excel 

Training Methods 

 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning 

4. Portfolio   
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Learning Experience 6: Develop Real Life Project  

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

1. Trainee will ask the instructor about 

about the learning materials 

1. Instructor will provide the learning materials 

‘Use Tools’ 

2. Read the Information sheet 

and complete the Self Checks 

& Check answer sheets on 

“Use Tools” 

2. Read Information sheet 5: Use Tools 

3. Answer Self-check 5: Use Tools 

4. Check your answer with Answer key 5: Use 

Tools 

3. Read the Job/Task Sheet and 

Specification Sheet and 

perform job/Task 

5. Job/Task Sheet and Specification Sheet  

Job Sheet-6: Create a Basic Accounting 

System (Grocery Shop) using Excel 
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Information Sheet 6: Develop Real Life Project  

 
 

Learning Objective: 

 

After completion of this information sheet, the learners will be able to explain, define 

and interpret the following contents: 

 

6.1. Project Types 

6.2. Determining Project Type 

6.3. Designing Project Structure 

 

 

6.1.  Project Types 

 

In the context of freelancing accounting, spreadsheets can be used to manage and 

organize various types of projects. Below are examples of common project types 

that freelancers might deal with: 

 

a. Accounting System 

An accounting system is essential for tracking income, expenses, and profits. 

Spreadsheets are often used for this purpose because they can provide an 

organized structure for financial records. 

 

Example: Income Statement: A simple spreadsheet template can be used to 

record revenue (invoices, payments received) and expenses (supplies, software 

subscriptions). 

•  

Date Description Income Expense Balance 

2025-01-01 Payment from Client A 500 

 

500 

2025-01-05 Purchase of Software 

 

100 400 

 

This spreadsheet will allow freelancers to track their financial performance over 

time. 

 

b. Inventory System 
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Freelancers may need an inventory system to manage items related to their 

business, such as office supplies, merchandise for reselling, or other physical 

goods used in projects. 

 

Example: Inventory Tracking: A spreadsheet can help track the items in stock, 

their quantity, and cost, making it easier to manage resources. 

 

 

Item Quantity Unit Cost Total Cost 

Printer Ink 10 20 200 

Laptop Stand 5 30 150 

 

c. Payroll System 

If the freelancer is employing others, managing payroll might also be necessary. 

Spreadsheets can calculate wages, taxes, and deductions based on hours worked 

or salary. 

  

Example:Employee Payroll: A payroll spreadsheet will show employee details, 

hours worked, pay rate, and the total amount due. 

 

Employee 

Name 

Hours 

Worked 

Hourly 

Rate 

Gross 

Pay 

Taxes 

(10%) 

Net 

Pay 

John Doe 40 25 1000 100 900 

Jane Smith 35 30 1050 105 945 

 

6.2. Determining Project Type 

 

Before starting a project, it’s important to assess the nature of the project to 

choose the most appropriate project type. In freelancing accounting, some key 

factors to consider when determining project type include: 

 

1. Project Scope: What is the primary goal of the project? Is it focused on 

managing income and expenses (Accounting System), tracking inventory 

(Inventory System), or calculating wages for employees (Payroll System)? 
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2. Complexity: If the project requires a lot of data, such as multiple 

employees or complex inventory, it might warrant an advanced 

spreadsheet structure with formulas and functions. 

3. Time Frame: How long will the project last? A short-term project might 

need a simpler accounting system, while a long-term project could involve 

more detailed tracking. 

4. Volume of Data: Larger projects might require the use of pivot tables, data 

validation, or charts in spreadsheets to effectively organize and analyze 

information. 

 

6.3. Designing Project Structure 

 

Designing an effective project structure in a spreadsheet ensures that 

data is organized, easy to access, and can be used for analysis. Here are 

steps for designing a project structure: 

 

a. Create Separate Sheets for Each Function 

For complex projects, creating multiple sheets for each section of 

the project can help maintain clarity. For example: 

• Sheet 1: Income and Expenses 

• Sheet 2: Inventory Tracking 

• Sheet 3: Payroll Information 

 

b. Use Tables and Headers 

Each sheet should have clear headers to define the data being 

collected (e.g., Date, Description, Amount). Using tables can help 

organize data and make it easier to filter and sort. 

 

c. Incorporate Basic Formulas and Functions 

Incorporating functions like SUM, AVERAGE, and IF statements 

allows for automatic calculations. For example, the balance in an 

accounting system can be calculated with a formula: 

• =SUM(C2:C10) - SUM(D2:D10) for calculating the balance 

after expenses. 

 

d. Incorporate Data Validation 

Data validation ensures that only valid data is entered in the 

spreadsheet. For example, a cell can be restricted to accept only 

dates or numbers, ensuring no invalid entries. 
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e. Visualize Data with Charts 

Using charts to visualize income, expenses, or inventory changes 

can provide insights at a glance. A bar chart for monthly income 

vs. expenses, or a pie chart for expense distribution, is an effective 

way to present data visually. 

 

Example of Structure Design for Accounting System: 

 

Sheet 1: Income and Expenses 

 

Date Description Income Expense Balance 

2025-

01-01 

Client A 500 

 

500 

2025-

01-05 

Software 

 

100 400 

 

Sheet 2: Inventory Tracking 

 

Item Quantity Unit Cost Total Cost 

Printer 

Ink 

10 20 200 

 

Sheet 3: Payroll 

 

Employee 

Name 

Hours 

Worked 

Hourly 

Rate 

Gross 

Pay 

Taxes 

(10%) 

Net 

Pay 

Mahmud 40 25 1000 100 900 
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Self-Check Sheet 6: Develop Real Life Project 

 

 

1. What is an Accounting System used for in freelancing? 

Ans:  

 

2. What does an Inventory System help manage? 

Ans:  

 

3. What does a Payroll System calculate? 

Ans:  

 

4. What is the importance of determining project type before starting a project? 

Ans:  

 

5. Why is data validation important in spreadsheet design? 

Ans:  
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Answer Key 6: Develop Real Life Project 

 

1. What is an Accounting System used for in freelancing? 

Ans: An Accounting System tracks income, expenses, and profits for a freelancer. 

 

2. What does an Inventory System help manage? 

Ans: An Inventory System helps manage items like office supplies and merchandise for 

resale. 

 

3. What does a Payroll System calculate? 

Ans: A Payroll System calculates wages, taxes, and deductions for employees. 

 

4. What is the importance of determining project type before starting a project? 

Ans: It ensures that the right system (accounting, inventory, or payroll) is chosen based on the 

project's scope and complexity. 

 

5. Why is data validation important in spreadsheet design? 

Ans: Data validation ensures only valid data is entered, reducing errors and maintaining data 

integrity. 
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Job Sheet-6: Create a Basic Accounting System (Grocery Shop) using 

Excel 

Working Procedure: 

  

1. Create an Excel Workbook Structure 

o Open Excel and create a new workbook. 

o Create separate sheets for different categories: 

▪ Sales Tracking: Record daily sales transactions. 

▪ Purchase Tracking: Record purchases of inventory. 

▪ Inventory Management: Track stock levels of goods. 

▪ Expense Tracking: Record expenses (e.g., rent, utilities). 

▪ Income Statement: Summarize income and expenses. 

2. Sales Tracking Sheet 

o Columns: Date, Item Name, Quantity Sold, Unit Price, Total Sales 

(Quantity x Unit Price). 

o Example: 

Date Item Name Quantity Sold Unit Price Total Sales 

2025-01-01 Apples 10 2.00 20.00 

2025-01-01 Rice 5 5.00 25.00 

3. Purchase Tracking Sheet 

o Columns: Date, Item Name, Quantity Purchased, Unit Price, Total 

Purchase (Quantity x Unit Price). 

o Example: 

Date Item Name Quantity Purchased Unit Price Total Purchase 

2025-01-01 Apples 50 1.80 90.00 

2025-01-02 Rice 30 4.50 135.00 

4. Inventory Management Sheet 

o Columns: Item Name, Starting Stock, Purchases, Sales, Ending Stock. 

o Example: 
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Item Name Starting Stock Purchases Sales Ending Stock 

Apples 0 50 10 40 

Rice 0 30 5 25 

5. Expense Tracking Sheet 

o Columns: Date, Expense Category (e.g., rent, utilities), Description, 

Amount. 

o Example: 

Date Expense Category Description Amount 

2025-01-01 Rent Monthly Rent 500.00 

2025-01-02 Utilities Electricity Bill 100.00 

6. Income Statement Sheet 

o Create a summary sheet that includes total income (from sales), total 

expenses, and net profit. 

o Use formulas to calculate totals and the difference between income and 

expenses. 
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Specification Sheet-6: Create a Basic Accounting System (Grocery 

Shop) using Excel 
 

 

Necessary Equipment 

 

Sl. No Name of Equipment Specification Unit Quantity 

1.  Computer  As Need No. 01 

2.  Spreadsheet Software  As Need No. 01 
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Reference  
 

1. "Excel for Accounting" by Lita Epstein (2010) – A practical guide for managing 

financial records and reports using Excel. 

2. "Excel for Finance and Accounting" by Michael Rees (2007) – Focuses on 

using Excel for financial analysis, budgeting, and reporting. 

3. "Financial Modeling in Excel For Dummies" by Danielle Stein Fairhurst (2018) 

– Covers financial modeling, forecasting, and analysis with Excel. 

4. "Excel Accounting: A Guide for Small Business Owners" by D. R. (Bob) 

Woolf (2002) – A guide for small business owners on managing finances with 

Excel. 

5. "Accounting and Financial Analysis Using Excel" by R. L. (Ray) Anderson 

(2006) – Teaches using Excel for accounting and financial data analysis. 
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Review of Competency 

Below is yourself assessment rating for module “Use Spreadsheets” 
 

Assessment of performance Criteria Yes No 

Sheet is prepared   

Sheet is formatted as per requirement   

Layout is made as required   

Functions are used as per requirements   

Functions are selected as required   

Data is accessed as per client's requirements   

Chart type is selected as per client's requirements   

Chart is created as required   

Chart is formatted as required   

Chart is presented as required   

Data is accessed as per client's requirements   

Data is formatted as Table   

Report is designed in Pivot as requirement   

Report is submitted to client   

Tools are selected   

Tools are learned   

Project type is determined   

Structure of project is designed   

Project is developed as per design   

 

 

I now feel ready to undertake my formal competency assessment. 

 

Signed: 

 

Date: 
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Development of CBLM 
 

The Competency based Learning Material (CBLM) of ‘Using Spreadsheets (Occupation: 

Accounting for Freelancing) for National Skills Certificate is developed by NSDA with the 

assistance of SAMAHAR Consultants Ltd.in the month of June, 2024 under the contract 

number of package SD-9C dated 15th January 2024. 

 

SL 

No. 

Name and Address Designation Contact Number  

1 Khan Mohammad 

Mahmud Hasan 

 

Writer Cell:  01714087897 

Email: kmmhasan@gmail.com 

2 A K M Mashuqur 

Rahman Mazumder 

 

Editor Cell: 01676323576 

Email : 

mashuq.odelltech@odell.com.bd 

3 Khan Mohammad 

Mahmud Hasan 

Co-Ordinator Cell:  01714087897 

Email: kmmhasan@gmail.com  

4 Md. Saif Uddin Reviewer Cell: 01723004419 

Email:engrbd.saif@gmail.com 

 


	Copyright
	How to use this Competency Based Learning Material (CBLM)
	Module Content
	Learning Outcome 1: Sheet formats and layouts can be created.
	Learning Experience 1: Creating Sheet formats and layouts
	Information Sheet 1: Create Sheet formats and layouts
	Self-Check Sheet - 1: Create Sheet formats and layouts
	Answer Key - 1: Create Sheet formats and layouts
	Job Sheet-1.1: Create a Sample Spreadsheet Demonstrating Formatting Tools
	Specification Sheet-1.1: Create a Sample Spreadsheet Demonstrating Formatting Tools

	Learning Outcome 2: Formulas and functions can be used.
	Learning Experience 2: Use Formulas and functions
	Information Sheet 2: Use Formulas and functions
	Self-Check Sheet - 2: Use Formulas and functions
	Answer Key - 2: Use Formulas and functions
	Job Sheet-2: Create a worksheet using Logical, Text and Financial Function
	Specification Sheet-2: Create a worksheet using Logical, Text and Financial Function

	Learning Outcome 3: Making Charts
	Learning Experience 3: Make Charts
	Information Sheet 3: Making Charts
	Self-Check Sheet - 3: Making Charts
	Answer Key - 3: Making Charts
	Job Sheet-3: Create a worksheet using Charts
	Specification Sheet-3: Create a worksheet using Charts

	Learning Outcome 4: Create table and PIVOT
	Learning Experience 4: Create table and PIVOT
	Information Sheet 4: Create table and PIVOT
	Self-Check Sheet 4: Create table and PIVOT
	Answer Key 4: Create table and PIVOT
	Job Sheet-4: Create a Sample PivotTable in Excel
	Specification Sheet-4: Create a Sample PivotTable in Excel

	Learning Outcome 5: Using Tools
	Learning Experience 5: Use Tools
	Information Sheet 5: Use Tools
	Self-Check Sheet 5: Use Tools
	Answer Key 5: Use Tools
	Job Sheet-5: Create a Worksheet include data validation, Duplicate Removing, Data sorting and Filtering
	Specification Sheet-5: Create a Worksheet include data validation, Duplicate Removing, Data sorting and Filtering

	Learning Outcome 6: Develop Real Life Project
	Learning Experience 6: Develop Real Life Project
	Information Sheet 6: Develop Real Life Project
	Self-Check Sheet 6: Develop Real Life Project
	Answer Key 6: Develop Real Life Project
	Job Sheet-6: Create a Basic Accounting System (Grocery Shop) using Excel
	Specification Sheet-6: Create a Basic Accounting System (Grocery Shop) using Excel

	Reference
	Review of Competency
	Development of CBLM



